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INTRODUCTION 

 

This trainee's manual includes all the knowledge and skills required in Computer System and 

Architecture specifically for the module of "Solidworks Designs.". Trainees enrolled in this 

module will engage in practical activities designed to develop and enhance their 

competencies. 

The development of this training manual followed the Competency-Based Training and 

Assessment (CBT/A) approach, offering ample practical opportunities that mirror real-life 

situations.  

The trainee's manual is organized into Learning Outcomes, which is broken down into 

indicative content that includes both theoretical and practical activities. It provides detailed 

information on the key competencies required for each learning outcome, along with the 

objectives to be achieved. 

As a trainee, you will start by addressing questions related to the activities, which are 

designed to foster critical thinking and guide you towards practical applications in the labor 

market. The manual also provides essential information, including learning hours, required 

materials, and key tasks to complete throughout the learning process. 

All activities included in this training manual are designed to facilitate both individual and 

group work. After completing the activities, you will conduct a formative assessment, referred 

to as the end learning outcome assessment. Ensure that you thoroughly review the key 

readings and the Points to Remember section. 
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MODULE CODE AND TITLE: GENSD401 SOLIDWORKS DESIGNS 

Learning Outcome 1: Set up SolidWorks space 

Learning Outcome 2:  Create Part 

Learning Outcome 3:  Assemble parts 

Learning Outcome 4:  Produce drawing 
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Learning Outcome 1: Set up Solidworks Space 
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Indicative contents 

1.1.Installation of SolidWorks software  

1.2.Selection of SolidWorks template  

1.3. Interface customization 

Key Competencies for Learning Outcome 1: Set Up SolidWorks space 

Knowledge  Skills  Attitudes  

● Definition of CAD 

software 

● Description of 

SolidWorks 

software 

● Description of 

solid work 

templates 

 

● Selecting suitable  

SolidWorks set up 

● Installing SolidWorks 

software  

● Launching SolidWorks 

software 

● Demonstrating 

customer user 

Interfaces  

● Customizing SolidWork 

user interface 

 

● Taking initiative 

● Being Problem Solver 

● Being Critical thinker 

● Having Passion  

● Having Adaptability 

● Being Decision Maker 

● Being Team worker 

● Having Creativity  

 

Duration: 10 hrs  

Learning outcome 1 objectives:   

By the end of the learning outcome, trainee will be able to:  

1. Define clearly Computer Aided Design(CAD) as used in Computer System and 

Architecture. 

2. Describe clearly SolidWorks software as used in Computer System and Architecture. 

3. Install correctly SolidWorks software based on computer system requirements. 

4. Describe properly SolidWorks Template /document based on its function. 

5. Select properly SolidWorks template according to the task requirements. 

6. Customize properly SolidWorks software user interfaces refer to the assigned tasks. 
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Resources 

Equipment Tools Materials 

● Computer 

● Projector 

 

● Storage media devices  

● SolidWorks Software full 

package 

 

● electricity 

● Internet connectivity 
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Indicative content 1.1: Installation of SolidWorks Software 

  

 
1: Answer the following questions: 

i. Define the following key terms: CAD, CAM, CADD, CAE, 2Dmodeling and   

3Dmodeling? 

ii. Describe what is SolidWorks software? 

iii. What are the applications of SolidWorks software?  

iv. List advantages and limitations of SolidWorks software. 

v. Highlight computer system requirements before installing SolidWorks? 

2:  Provide your answers on paper/flipchart.  

3:  Present your findings. 

4: Pay attention on trainer’s clarifications and ask questions if any. 

5:  For more clarification, read the key readings 1.1.1 in trainee manual 

Key readings 1.1.1.: Description of SolidWorks software 

● Definitions of Terms: 

✔ CAD (computer-aided design): It is the use of computer-based software to aid 

in design processes. CAD software is frequently used by different types of 

engineers and designers. CAD software can be used to create two-dimensional 

(2D) drawings or three-dimension(3D) models 

✔ CAM (Computer-Aided Manufacturing): CAM involves using computer 

software and machinery to control and automate manufacturing processes.  

✔ CADD (Computer-Aided Design and Drafting): CADD is a term used to describe 

the combination of CAD and drafting, which involves creating technical 

drawings with precise dimensions and annotations.  

✔ CAE (Computer-Aided Engineering): CAE involves using computer software to 

simulate and analyze a status of designs under different conditions. It helps 

engineers to evaluate factors such as stress, thermal effects. 

Duration: 4 hrs  

 

 

Theoretical Activity 1.1.1: Description of SolidWorks Software 

Tasks: 
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✔ 2DModeling: 2Dmodeling refers to the creation of digital representations of 

objects or designs in two dimensions, typically using lines, curves, and shapes. 

It involves working with shapes and drawings in a two-dimensional space, 

length and width, without depth or perspective.  

✔ 3DModeling: 3D modeling involves creating three-dimensional digital 

representations of objects or designs. It allows for the creation of complex and 

realistic models that can be viewed and analysed from different angles.  refers to 

the three spatial dimensions of width, height and depth SolidWorks description. 

✔ SolidWorks is a 3D parametric design software that is used to design all sorts of 

products such as automobiles, computer peripherals, marine equipment, 

airplane parts, cell phones, cameras, furniture, electrical assemblies, glasses, 

lighting fixtures, toys, vacuum cleaners, or any other like products. it was 

developed by Massachusetts Institute of Technology (MIT) graduate Jon Hirsch 

tick and was bought by Dassault Systems in 1997. The software now 

encompasses a number of programs that can be used for both 2D and 3D design.  

● Application of SolidWorks 

✔ Some common applications of SolidWorks include:  

● Mechanical Engineering. 

● Product Design and Development. 

● Architecture and Construction. 

● Electrical and Electronics. 

● Automotive and Transportation. 

● Aerospace and Defense. 

● Advantages and limitations of SolidWorks 

✔ Advantages of SolidWorks:  

● User-Friendly Interface: SolidWorks provides an intuitive and user-friendly 

interface that makes it easy to learn and use for both beginners and 

experienced users. 

● Comprehensive Design Tools: SolidWorks offers a wide range of tools and 

features for creating complex 3D models, performing simulations, 

generating technical drawings, and collaborating with others.  

● Parametric Modeling: SolidWorks supports parametric modeling, allowing 

users to easily make changes to designs and have those changes 

automatically update throughout the model.  

● Integration with Other Software: SolidWorks can integrate with other 

software applications, such as simulation software, data management 

systems, and manufacturing software, facilitating a seamless workflow.  

● Extensive Online Community and Support: SolidWorks has a large online 

community of users and resources, including forums, tutorials, and 

documentation, providing support and assistance for users.  
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✔ Limitations of SolidWorks:  

● Cost: SolidWorks is a commercial software and can be expensive, especially 

for individual users or small businesses. 

● System Requirements: SolidWorks requires a computer system with 

sufficient hardware resources to run smoothly. Older or lower-spec systems 

may struggle to handle complex designs. 

● Steep Learning Curve: While SolidWorks has a user-friendly interface, 

learning and mastering all the advanced features and capabilities may 

require time and effort. 

● Software Updates: SolidWorks releases new versions and updates regularly, 

which may require users to adapt to changes in the software and may 

require additional training or support. 

 

● Computer system requirements 

The specific requirements may vary slightly depending on the version of SolidWorks 

you're installing. It's always recommended to check the official SolidWorks 

documentation for the most up-to-date information. 

✔ System Requirements: 

● Operating System: Windows 11 or Windows 10 (64-bit)    

● Processor: Intel® Core i5, i7, or equivalent AMD® processor    

● Memory: 8GB or more     

● Hard Drive: Standard or Solid State Drive (SSD) with at least 250GB free 

space 

 

 
1. You are asked to perform the following task: 

As a computer technician, you are requested to go to the computer lab to 

install SolidWorks software on the computers. 

2. Read the steps from key readings 1.1.2 in trainee manual 

3. Follow the demonstration from your trainer of how to install SolidWorks. 

4. Install SolidWorks software by simulating the demonstration of trainer. 

5. Ask for support if there is an occurred issue. 

  

 

Practical Activity1.1.2: Installing SolidWorks software 

Task: 
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Key readings 1.1.2: Installing SolidWorks software   

Installing SolidWorks software Steps : 

Step 1.Ensure that the internet is disconnected to computer 

  

Step 2.Turn off any antivirus computer window protection and firewalls 

Step 3. Go to control panel then click on programs and features for turning window 

features on/off 

Step 4. Ensure.netframework3.5(includes Net2.0and 3.0) and 

ensure.netframework4.8 advanced services 

Step 5. Go to downloaded SolidWorks folder then unzip that folder and unzip crack 

folder 

Step 6. After Do double clicking on serial licensing then click yes to ensure that all 

serial licensing is added to registry  

Step 7. Click on SolidWorks crack folder  then copy flex.net_server 

Step 8. Go to local disc and paste it  in local disc C 

Step 9. Click on flex.net server install and run as administrator 

Step 10. After you will go back to downloaded unzipped SolidWorks folder then do 

double click on SolidWorks set up.exe 

Step 11. click ok  

Step 12. click next 

Step 13. Click install now then click ok 

Step 14. Click finish 

Step 15. Don’t open SolidWorks until you followed these steps for activation or 

cracking 

Step 16. Do double clicking SolidWorks enabler code for adding code to registry 

Step 17. Go to crack folder and copy SOLIDWORKS CORP into program file in order to 

replace the existing  

Step 18. Open SolidWorks and start navigating 
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Term definition: 

● CAD (Computer-Aided Design) uses software for design processes, enabling the 

creation of 2D drawings and 3Dmodels. 

● CAM (Computer-Aided Manufacturing) automates manufacturing processes 

through software and machinery. 

● CADD (Computer-Aided Design and Drafting) combines CAD with drafting to 

produce technical drawings with precise dimensions. 

● CAE (Computer-Aided Engineering) simulates and analyzes designs under various 

conditions, assessing factors like stress and thermal effects. 

● 2D vs. 3DModeling: 2Dmodeling creates flat representations, while 3Dmodeling 

produces complex digital objects viewable from multiple angles. 

✔ SolidWorks Overview:  

SolidWorks is a 3D parametric design software used for various industries, developed by 

Jon Hirsch tick and acquired by Dassault Systems in 1997. 

✔ Applications of SolidWorks: Common uses of SolidWorks include mechanical 

engineering, product design, architecture, automotive, aerospace, and electronics. 

✔ Advantages: SolidWorks features a user-friendly interface, comprehensive design 

tools, parametric modeling, integration capabilities, and strong community 

support. 

✔ Limitations: Challenges include high costs, hardware requirements, a steep 

learning curve, and the need for regular software updates. 

✔ System Requirements:  

✔ Recommended specifications include Windows 10/11 (64-bit), Intel Core i5/i7 or 

equivalent AMD processor, 8GB RAM, and 250GB free storage space. 

✔ Installing SolidWorks software Steps: 

1) Disconnect Internet: Ensure the computer is offline before starting the installation. 

2) Disable Security Software: Turn off any antivirus programs and firewall protection. 

3) Check Windows Features: Go to Control Panel, then Programs and Features, to 

enable necessary Windows features. 

4) Verify .NET Framework: Ensure .NET Framework 3.5 (including 2.0 and 3.0) and 

.NET Framework 4.8 Advanced Services are installed. 

5) Prepare Installation Files: Navigate to the downloaded SolidWorks folder, unzip it, 

and also unzip the crack folder. 

6) Add Serial Licensing: Double-click the serial licensing file and confirm to add it to 

the registry. 

7) Install Flex.Net Server: Copy the Flex.Net Server file to the C: drive and run the 

installer as an administrator. 

 Points to Remember 
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8) Run SolidWorks Setup: In the unzipped SolidWorks folder, double-click on 

setup.exe to begin the installation. 

9) Follow Installation Prompts: Click "OK," then "Next," and select "Install Now," 

followed by "Finish." 

10) Activation Steps: Do not open SolidWorks until you complete the activation steps, 

including adding the SolidWorks enabler code to the registry and replacing files in the 

program directory. 

11) Start Using SolidWorks: Once all steps are completed, open SolidWorks and begin 

navigating. 

 

  
ABD computer peripheral manufacturing company ltd, wants to hire a technician who is 

able to install SolidWorks software because this company has a problem of not having 

enough computers for satisfying their clients. As a technician you are hired to install 

SolidWorks software to their computers. A task includes ensuring that the installation 

process is smooth, software is fully operational and any potential installation issues are 

addressed effectively.  

Application of learning 1.2. 
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 Indicative content 1.2: Selection of SolidWorks template  

  

 
1. You are asked to answer the following questions: 

i. Describe the three primary types of SolidWorks templates/documents? 

ii. What are primarily the SolidWorks file extension formats? 

iii. What are the most widely used drawing template standards? 

iv. What are Some of the most widely used drawing template standards? 

2. Provide the answer for the questions and write them on papers/ flipchart. 

3. Present the findings/answers  

4. Pay attention on trainer’s clarifications and ask questions if there are any. 

5. For more clarification, read the key readings 1.2.1 

Key readings 1.2.1.: Description of SolidWorks Template 

There are three primary types of SolidWorks documents (template): 

1. Part template /Document (. sldprt) 

✔ It is used to create individual 3D components. 

✔ It contains the geometry and design details of a single part. You can create solid 

models, sheet metal parts, weldments, and more using various sketching, 

extrusion, and feature tools. 

✔ Designing individual components that will later be assembled together in an 

assembly document. 

● File Extension: sldprt 

 
Image 1:Part Template 

 

2. Assembly template  /Document (.sldasm) 

✔ It is Used to assemble multiple parts into a single, functional unit. 

Duration: 3hrs  

 

 

Theoretical Activity 1.2.1:  Description of SolidWorks Template 

Tasks: 
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✔ It allows the user to position and mate parts together to define the relationships 

between components. Assemblies can also include sub-assemblies (assemblies 

within assemblies). 

✔ Creating complex products or systems by combining individual parts, such as 

mechanical devices, computer peripherals, machinery, and consumer products. 

 
Image2: Assembly Template 

3. Drawing Template /Document (.slddrw) 

✔ It is used to create 2D representations of parts or assemblies. 

✔ It generates detailed drawings from parts or assemblies, including views (front, 

side, top), dimensions and annotations. These drawings are essential for 

manufacturing and documentation purposes. 

✔ Providing detailed, standardized blueprints for manufacturing, fabrication, or 

assembly processes. 

 

 
Image 3: Drawing Template 

● Some of the most widely used drawing template standards: 

✔ ISO (International Organization for Standardization): Offers a comprehensive set 

of standards for various industries, including mechanical engineering, 

construction, and manufacturing. 

✔ ANSI (American National Standards Institute): Provides standards primarily used in 

the United States, often aligned with ISO standards. 

✔ ASME (American Society of Mechanical Engineers): Focuses on standards for 

mechanical engineering, including design, manufacturing, and testing. 

✔ JIS (Japanese Industrial Standards): Used primarily in Japan and is often compatible 

with ISO standards. 

✔ DIN (German Institute for Standardization): Widely used in Germany and Europe, 

offering a range of standards for various industries. 

● Note that: The paper size used in SolidWorks depends on the specific ISO standard 

you are following and the type of drawing you are creating.  
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1: Read and answer the following question: 

As computer technician, you are asked to select at least one SolidWorks Template and read 

its interfaces.  

2: Provide the answer for the asked question and write them on papers.  

3:  Present the findings/answers to the whole class  

4:  For more clarification, read the key readings 1.2.1. 

5:  In addition, ask questions where necessary. 

Key readings 1.2.1 : Selecting SolidWorks Template 

1. Part Template. 

Steps: 

1. Create a new part: Go to File > New > Part. 

2. Define the template's properties: Set the units and document name  

3. Add features and dimensions: Create the basic geometry or features that 

you want to include in your template. 

4. Set material and other properties: Assign the desired material and define 

other properties as needed. 

5. Save the template: Go to File > Save As and choose a location to save the 

template. Give it a descriptive name with a .sldprt extension. 

2.Assembly Template 

Steps: 

1. Create a new assembly: Go to File > New > Assembly. 

2. Define the template's properties: Set the units, document name, and other 

relevant properties. 

3. Insert components: Add the components that you want to include in your 

template. 

4. Define relationships and constraints: Establish the desired relationships and 

constraints between the components. 

 

Practical Activity 1.2.2: Selecting SolidWorks Template 

 

Tasks: 
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5. Save the template: Go to File > Save As and choose a location to save the 

template. Give it a descriptive name with a .sldasm extension. 

3.Drawing Template 

Steps: 

1. Create a new drawing: Go to File > New Drawing. 

2. Define the template's properties: Set the units and sheet size 

3. Insert views: Add the desired views of the part or assembly to the drawing. 

4. Add dimensions and annotations: Create dimensions and notes 

5. Save the template: Go to File > Save As and choose a location to save the 

template. Give it a descriptive name with a .slddrw extension. 

 

 
● There are three primary types of SolidWorks documents (template): 

✔ Part template /Document (.sldprt) 

✔ ASSEMBLY TEMPLATE  /Document (.sldasm) 

✔ Drawing Template /Document (.slddrw) 

● SolidWorks primarily uses the following file extension formats: 

● sldprt 

● sldasm 

● slddrw 

● Some of the most widely used drawing template standards: 

● ISO  

● ANSI  

● ASME  

● JIS  

● DIN  

● In selecting SolidWorks Templates trainee must know the steps of Selecting 

SolidWorks Templates 

  

 Points to Remember 
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ABD computer peripheral manufacturing company ltd, wants  to hire a technician who is 

a professional worker of  CAD Software such as SolidWorks, As a technician first turn on  

computer, launch SolidWorks Software and  Select part, Assembly and drawing template.  

Application of learning 1.2. 
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 Indicative content 1.3: Interface customization 

 
 

 
1: Answer the following questions refer to the introduction:  

i. Identify SolidWorks software Interfaces 

ii. What is the purpose of customizing Toolbars and Menus? 

iii. Identify the functions of tool bars and menu bar customization 

iv. What is the purpose of customizing Keyboard shortcuts? 

v. What are the functions of using keyboard shortcuts in SolidWorks? 

vi. What are the functions of customizing the Command Manager in SolidWorks? 

vii. What is the purpose of customizing the Command Manager in SolidWorks? 

viii. What are the functions of customizing the Custom Colours and Themes ? 

ix. Highlight the functions of mouse gestures 

x. What are the functionsof customizing the Custom Property Tab Builder ? 

2: Write the findings on paper or flip chart 

3: Present the findings/answers on paper/flip chart  

4: Pay attention on trainer’s clarifications and ask questions if any. 

5: Read the key readings 1.2.1 for more clarification 

Duration: 3 hrs  

 

 

Theoretical Activity 1.3.1:  Description of SolidWorks customer Interfaces 

 
Tasks: 
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Key readings 1.3.1.: Description of SolidWorks customer Interfaces 

 

✔ The SolidWorks user Interface is primarily comprised of nine major sections: 

1. The Menu Bar 

2. The SOLIDWORKS Menus 

3. The Quick Access Tools 

4. The Command Manager 

5. The Feature Manager Design Tree 

6. The Heads-Up View Toolbar 

7. The Graphics Area 

8. The Task Pane 

9. The Status Bar 
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● Interface Customization 

✔ Toolbars and Menus Customization: Organize frequently used commands and 

features for easy access.  

● Toolbars: Horizontal or vertical bars that contain icons or buttons representing 

frequently used commands. You can customize their appearance, content, and 

arrangement to suit your preferences. 

● Function of tools bar Customization:  

1. Create custom toolbars with specific commands. 

2. Rearrange icons within existing toolbars. 

● Menus: Hierarchical lists of commands that can be accessed by clicking on a menu 

bar or a button. You can customize the items within menus, their arrangement, 

and even create new menus 

● Function of menu bar Customization:  

1. Add or remove menus from the menu bar. 

2. Customize the content of individual menus. 

 

✔ Keyboard Shortcuts Customization: Quickly execute commands using keyboard 

combinations. 

● Keyboard shortcuts: Combinations of keys that can be pressed to quickly perform 

specific actions. You can customize these shortcuts to use your preferred key 

combinations for frequently used commands. 

● Function of keyboards shortcuts customization 

1. Assign custom shortcuts to frequently used commands. 

2. Modify existing shortcuts. 

 3.Create shortcut sets for different tasks or workflows. 

● The predefined keyboard shortcuts options:  

Ctrl+1 . . . . . . . . . . . . . . . . . . . . . Front Orientation  

Ctrl+2 . . . . . . . . . . . . . . . . . . . . . Back Orientation  

Ctrl+3 . . . . . . . . . . . . . . . . . . . . . Left Orientation  

Ctrl+4 . . . . . . . . . . . . . . . . . . . . . Right Orientation  

Ctrl+5 . . . . . . . . . . . . . . . . . . . . . Top Orientation  

Ctrl+6 . . . . . . . . . . . . . . . . . . . . . Bottom Orientation  

Ctrl+7 . . . . . . . . . . . . . . . . . . . . . Isometric Orientation  

Ctrl+8 . . . . . . . . . . . . . . . . . . . . . View Normal To  

Spacebar . . . . . . . . . . . . . . . . . .  View Orientation dialog  

Ctrl . . . . . . . . . . . . . . . . . . . . . . . Hold and select multiple items with mouse button  

Ctrl+Tab . . . . . . . . . . . . . . . . . . .Switch between documents 

✔ Mouse Gestures Customization: Perform actions using specific mouse 

movements. 
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● Mouse gestures: Combinations of mouse movements and clicks that can be used 

to perform actions. You can customize these gestures to create shortcuts for 

specific tasks or to navigate the application more efficiently. 

● Functions of Mouse gestures: 

1.Define gestures for zooming, panning, and rotating views.  

2.Create custom gestures for specific commands or tasks. 

3.Mouse buttons operate in the following ways:  

4.Left: Selects menu items, entities in the graphics area, and objects in the feeature 

Manager design tree.  

5.Right: Displays the context-sensitive shortcut menus.  

6.Middle: Rotates pans, zooms a part or an assembly, and pans in a drawing.  

✔ Command Manager Customization: Manage and organize commands within 

SolidWorks. 

 

● Command manager: A central repository of commands and their associated 

actions. You can customize the command manager by creating new commands, 

modifying existing ones, and assigning them to different menus, toolbars, or 

keyboard shortcuts. 

● Functions of  command manager 

1.Create new commands or modify existing ones. 

2.Assign commands to different toolbars or menus. 

3.Organize commands into categories or groups. 

✔ Shortcut Bars Customization: Provide quick access to frequently used commands 

● Shortcut bars: Customizable bars that can be placed on the application's interface 

to provide quick access to frequently used commands. You can customize the 

content and arrangement of these bars. 

Examples:  

1. Create custom shortcut bars with specific commands. 

2. Customize the appearance and arrangement of shortcut bars. 

3. Add or remove shortcut bars from the interface. 

✔ Custom Colours and Themes Customization: Change the visual appearance of 

SolidWorks. 

● Custom colors and themes: The appearance of the application's interface can be 

customized using different color schemes and themes. You can choose from 

predefined themes or create your own to match your preferences. 

 Examples:  

1.Choose from predefined color schemes or create custom ones. 

2.Apply different themes to change the overall look and feel. 

3.Customize individual elements like backgrounds, fonts, and icons. 
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✔ Workspace Customization: Arrange windows, panels, and other elements to suit 

your workflow. 

● Workspace: The layout and arrangement of windows, panels, and other elements 

within the application. You can customize your workspace to optimize your 

workflow and improve productivity. 

Examples:  

1. Dock or undock windows. 

2. Resize and reposition windows. 

3. Create custom workspaces for specific tasks or projects. 

✔ File Locations Customization: Specify default locations for saving and opening 

files. 

● File locations: The default locations for saving and opening files. You can 

customize these locations to specify your preferred directories for different types 

of files. 

Examples:  

1. Set custom default folders for different file types (e.g., parts, assemblies, 

drawings). 

2. Create project folders to organize related files. 

✔ Custom Property Tab Builder Customization: Create and customize property tabs 

for custom features or components. 

✔ Custom property tab builder: A tool that allows you to create and customize 

property tabs within the application. You can use this tool to define the properties 

that are displayed and how they are arranged. 

● Functions of Custom property tab builder 

1. Define custom properties and their data types. 

2. Set default values for properties. 

3. Create custom property tabs with specific layouts. 

 

 
1: As computer technician you are tasked  to customize a SolidWorks interfaces Such as 

toolbars and Menus, Keyboard Shortcuts, Mouse Gestures ,Command Manager 

Customization ,Shortcut Bars ,Custom Colors and Themes Workspace Customization ,File 

Locations  and Custom Property Tab Builder  

2: Read the steps from key reading 1.3.2 in trainee ‘manual 

3:Follow the demonstrated steps from trainer of how to customize each SolidWorks 

Interfaces. 

 

Practical Activity 1.3.2: Customizing SolidWorks customer Interfaces 

 

Task: 
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4: Customize SolidWorks Software interfaces by simulating the shown demonstration. 

5: Ask for support if there is an occurred issue 

 

Key readings 1.3.2: Customizing SolidWorks  Interfaces 
 

● Customizing Toolbars and Menus  

✔ Steps: 

1. Click on down ward arrow on the right side of Setting  

2. Click on customize 

3. Dialog box will appear with the following titles: 

 

 
 

4.Then hover your cursor to each one you want to customize 

● SolidWorks Command Manager with customizable tabs  

✔ Steps: 

1) Right-click on a tab in the Command Manager. 

2) Choose "Customize..." 

3) Select the "Command Manager" tab. 

4) Add, remove, or rearrange commands within the tabs. 

5) Create new tabs: Click the "New" button to create a new tab. 

● SolidWorks shortcut bar with customizable icons Steps: 

1) Right-click on an empty area of the shortcut bar. 

2) Choose "Customize..." 

3) Select the "Shortcut Bars" tab. 

4) Add, remove, or rearrange commands on the shortcut bar. 

● Custom Colors and Themes customizing  

✔ Steps: 

1) Go to Tools > Options > System Options. 

2) Select the "Colors" tab. 

3) Choose a predefined color scheme or create your own. 

● Workspace Customizing 

✔ Steps: 

1) Go to View > Workspaces. 

2) Choose a predefined workspace or create your own. 

3) Customize the workspace by adding or removing toolbars and panels. 

4) SolidWorks Options dialog box with the File Locations tab  
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● File Locations 

✔ Steps 

1) Go to Tools > Options > System Options. 

2) Select the "File Locations" tab. 

3) Set the default location for saving files. 

● Custom Property Tab Builder 

✔ Steps: 

1) Go to Tools > Options > System Options. 

2) Select the "Custom Property Tab Builder" tab. 

3) Create a new custom property tab. 

4) Add custom properties to the tab. 

  

 
✔ The SolidWorks user Interface is primarily comprised of nine major sections: 

1. The Menu Bar 

2. The SOLIDWORKS Menus 

3. The Quick Access Tools 

4. The Command Manager 

5. The Feature Manager Design Tree 

6. The Heads-Up View Toolbar 

7. The Graphics Area 

8. The Task Pane 

9. The Status Bar 

● Trainee must know the steps of customizing the following elements: 
Toolbars and Menus, Keyboard Shortcuts, Mouse Gestures ,Command Manager 
Customization ,Shortcut Bars ,Custom Colors and Themes Workspace Customization ,File 
Locations  and Custom Property Tab Builder 

 
ABD computer peripheral manufacturing company ltd, wants to hire a technician who is 

a professional worker of CAD Software such as SolidWorks. As a technician you are hired 

to customize SolidWorks software before starting to draw by using Solid works. An task 

includes ensuring toolbars and Menus, Keyboard Shortcuts, Mouse Gestures, Command 

Manager interfaces are well customized.  

 Points to Remember 

Application of learning 1.3. 
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 Learning outcome 1 end assessment 

 

 

Part I. Read carefully the following statements and choose the correct answer. 

1. Which of the following SolidWorks document is used to design individual 3D 

components? 

a) Template (.slddrw) 

b) Sketch Document (.sldsk) 

c) Part Template (.sldprt) 

d) Assembly Template (.sldasm) 

2. What is the primary function of toolbars in SolidWorks? 

a) To manage file locations 

b) To display detailed properties of parts 

c) To create assembly drawings 

d) To contain icons for frequently used commands 

3. Which of the following can be the purpose of customizing the menus of 

SolidWorks? 

a) The size of the icons 

b) The number of commands in the Command Manager 

c) The color of the application interface 

d) The arrangement and content of menu items 

4. What do keyboard shortcuts allow you to do in SolidWorks? 

a) Quickly execute commands using key combinations 

b) Manage file locations 

c) Customize the appearance of toolbars 

d) Change the layout of the workspace 

5. Which of the following keyboard shortcuts is used for front orientation? 

a) Ctrl+7 

b) Ctrl+5 

c) Ctrl+2 

d) Ctrl+1 

6. What is the purpose of mouse gestures in SolidWorks? 

a) To perform actions using specific mouse movements 

b) To organize commands in the Command Manager 

c) To display context-sensitive menus 

d) To create custom toolbars 

7. How can you customize the Command Manager in SolidWorks? 

a) By rearranging the menu bar 

b) By creating new commands and modifying existing ones 

Written assessment  
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c) By changing its color scheme 

d) By adjusting the workspace layout 

8. Which customization option allows you to change the visual appearance of 

SolidWorks? 

a) Shortcut Bars 

b) File Locations 

c) Custom Colors and Themes 

d) Command Manager 

9. What can you customize regarding file locations in SolidWorks? 

a) The number of toolbars 

b) The layout of the Task Pane 

c) The color of the Command Manager 

d) Default locations for saving and opening files 

10. What is the purpose of the Custom Property Tab Builder in SolidWorks? 

a) To manage file locations 

b) To customize keyboard shortcuts 

c) To create and customize property tabs for features or components 

d) To arrange toolbars 

11. Which of the following is NOT a major section of the SolidWorks User Interface? 

a) Status Bar 

b) Menu Bar 

c) Graphics Area 

d) File Manager 

Part 2. 

1. Match column term and definition in column of answer by using corresponding letter. 

Answer TERM DEFINITION 

1 ……………… 1. CAD (Computer-

Aided Design) 

a) Creating designs that show length, width, 

and depth, giving objects a realistic 

appearance. 

2 ……………… 2. SolidWorks 

 

b) Creating flat drawings with length and 

width, without depth. 

3………………  

3. 2DModeling 4.  
 

c) A software used for 3Dmodeling, 

simulation, and product design. 

4………………  

4. 3DModeling 5.  
 

d) A system used for creating, modifying, 

and optimizing designs digitally. 
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5……………. 5.CAE e) Features, Sketch, Evaluate, View, 

SolidWorks Resources 

 

2. Match Column A and B in column of Answer by using corresponding letter. 

ANSWERS Column A Column B 

 

1)... 1) SolidWorks templates include ,……….. a)  User-friendly, cost-

effective, parametric 

design, wide industry use 

2)... 2) Tabs that appear when you first 

launch SolidWorks,……. 

b) Command Manager, 

Feature Manager Tree, 

Graphics Area, Menu Bar 

3)... 3) Examples of SolidWorks user 

interfaces….. 

c) Part ,Assembly, Drawing 

4)… 4) Advantages of using SolidWorks in 

architecture and computer systems, 

……….. 

d)  Features, Sketch, Evaluate, 

View, SolidWorks 

Resources 

 

3. Match the correct descriptions in following column A and column B in column C 

 

Column A Column B Column C 

1) .sldprt 

 

a) A widely recognized drawing standard 

used internationally 

1) … 

2) .sldasm 

 

b) A drawing standard used predominantly in 

the U.S. 

2) … 

3) .slddrw 

 

c) A native file format for parts in SolidWorks 3) … 

4) ISO 

 

d) The largest ISO paper size (841 x 1189 

mm) 

 

4) … 

5) ANSI 

 

e) A file format used for assemblies of 

multiple parts 

 

5) … 

 

Part 3.Read the following statement and choose the correct answer (multiple selections are 

allowed)  

Q1. Customizing keyboard shortcuts in SolidWorks helps to:  

a) Enhance visual design 
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b) Improve access to frequently used commands 

c) Increase mouse usage 

Q2. Match the benefits of using keyboard shortcuts in SolidWorks:  

a) Slows down workflow 

b) Speeds up design tasks 

c) Improves precision 

Q3. Match the benefits of customizing the Command Manager in SolidWorks:  

a) Reduces screen clutter 

b) Makes tools harder to find 

c) Organizes tools for easier access 

d) Personalizes the workspace layout 

 

  

ABD ltd wants to install SolidWorks software into their computers for better producing  

CAD based Computer peripherals  at their company, as CAD professional ,you are asked 

to install SolidWorks software .Task includes the installation of SolidWorks Software 

version 2023, creating template and customizing the interfaces.  

Practical assessment 
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Learning Outcome 2: Create Part 
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Indicative contents 

2.1. Selecting of plane  

2.2. Creating sketch 

2.3. Applying part features 

2.4. Applying Visualization 

2.5. Exporting part 

Key Competencies for Learning Outcome 2: Create Part 

Knowledge  Skills  Attitudes  

✔ Selection of Plane in 

SolidWorks software 

✔ Application of part 

features in 

SolidWorks software 

✔ Application of 

visualization in 

SolidWorks software 

 

✔ Selecting Plane in 

SolidWorks software 

✔ Creating Sketch  in 

SolidWorks software 

✔ Applying Part Features 

in SolidWorks software 

✔ Applying Visualization in 

SolidWorks software 

✔ Exporting part in 

SolidWorks software 

 

✔ Taking initiative 

✔ Having Creativity 

✔ Being Critical 
thinker 

✔ Being Problem 
Solver 

✔ Having Passion  

✔ Having 
Adaptability 

✔ Being Decision 
Maker 

✔ Being Team 
worker 
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Duration: 20 hrs  

Learning outcome 2 objectives:   

By the end of the learning outcome, the trainees will be able to:  

1.Select properly SolidWorks software Standard Plane  and custom plane based on 

assigned. task. 

 2. Create appropriately  a Sketch  in SolidWorks software based on related task. 

3.Define  different Features tools use in SolidWorks software. 

4.Apply  correctly Visualization in SolidWorks software related to the work. 

5.Export  properly part in SolidWorks software refer to the acquired file extension format. 

Resources 

Equipment   Tools  Materials   

✔ Computer 

✔ Projector 

✔ Whiteboard 

✔ SolidWorks software  

✔ Storage media devices 

✔ SolidWorks tutorials 

✔ Marker pen 

✔ A4 Papers or flip chart 

✔ Internet connectivity 
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Indicative content 2.1: Selecting of Plane 

  

 
1:Answer the following questions refer to the introduction: 

i. What are the types of  planes made up SolidWorks? 

ii. What are the commonly used standard planes in SolidWorks? 

iii. what  are the types of references necessary to define custom plane? 

iv. Identify the steps to be followed for creating custom planes to suit your specific design 

needs? 

v. What is the importance of defining the correct orientation of a plane in SolidWorks ? 

2: Write the findings on paper or flip chart 

3: Present the findings/answers on paper/flip chart  

4: Pay attention on trainer’s clarifications and ask questions if any. 

5:  For more clarification, read the key readings 2.1.1 in Trainee manual 

Key readings 2.1.1: Selection of SolidWorks Planes 

Selecting the appropriate plane is crucial for starting your design.  

● SolidWorks Software is  made up with two types of planes: 

✔ Standard plane 

✔ Custom plane 

● Standard plane  is contained by 3 default planes such as: 

● Front plane: The front plane is the reference plane that represents the front-

facing view of your part. It is typically used as the starting point for sketching 

features that are visible from the front of the part.  

● Top plane: The top plane is the reference plane that represents the top or plan 

view of your part. It is often used as the starting point for sketching features that 

are visible from the top of the part.  

● Right plane: The right plane is the reference plane that represents the right-side 

view of your part. It is commonly used as the starting point for sketching features 

that are visible from the right side of the part.  

● Here are the commonly used standard planes:  

✔ Standard plane  

Duration: 3hrs  

 

 

Theoretical Activity 2.1.1: Selection of SolidWorks Planes 

Tasks: 
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SolidWorks provides standard planes that help define the orientation and position 

of your part In addition to the standard planes provided in SolidWorks, you also have 

the option to create custom planes to suit your specific design needs. 

✔ Custom plane  

Custom planes allow you to define planes that are oriented at different angles or 

positions, providing flexibility in your part creation process.  

● Selection of references for Plane Creation: 

✔ To define a custom plane, SolidWorks needs at least one reference. You can use 

the following  

✔ Types of references: 

● A face 

● A plane (existing standard planes like Front, Top, Right) 

● An edge 

● A point 

● A sketch 

 

 
1. Refer to the introduction you are asked to perform the following task: 

As computer technician you are asked to select standard planes and after that create 

your own custom plane in SolidWorks. 

2. Read the steps from key reading 2.1.2 in trainee’ manual. 

3. Pay attention to your trainer on how to select plane in SolidWorks software. 

4. Select plane in SolidWorks Software by simulating your trainer. 

5. Ask for clarification from trainer if any. 

Key readings 2.1.2. Selecting planes 

● Selecting standard planes Steps: 

1. Start by opening a new part file in SolidWorks.  

2. Access the Feature Manager Design Tree  

3. Locate the Standard Planes in the Feature Manager 

4. Select the Desired Plane by clicking on one of the planes (Front, Top, or Right) 

depending on the orientation you want for your sketch. 

 

Practical Activity 2.1.2: Selecting planes 

Task: 
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5. Start a New Sketch by click on the Sketch tab on the Command Manager 

toolbar 

6. View Normal to Plane and choose Normal To from the context menu.  

7. Begin Sketching use sketch tools to create 2D geometry on the plane. 

● Creating a custom plane steps:  

1. Open a part or assembly document in SolidWorks.  

2. Go to the "Features" tab in the Command Manager.  

3. Click on the "Reference Geometry" dropdown menu and select "Plane."  

4. A dialog box will appear, allowing you to define the orientation and position 

of the custom plane.  

5. Choose the reference entities or coordinate system that will determine the 

location and orientation of the plane.  

6. Specify the distance or angle from the reference entities to position the plane 

accurately.  

7. Click "OK" to create the custom plane. 

 

● SolidWorks Software is  made up with two types of planes: 

1. Standard plane 

2. Custom plane 

✔ Standard plane  is contained by three (3) default planes such as: 

● Front plane  

● Top plane 

● Right plane  

● Custom plan: Is created when they want to draw multi complex drawings. 

✔ While selecting standard planes steps trainee must know the steps to be followed 

✔ While creating a custom plane steps trainee must know the steps to be followed  

✔ Trainee must know the Types of references during the creation of custom plane 

● A face 

 Points to Remember 
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● A plane (existing standard planes like Front, Top, Right) 

● An edge 

● A point 

● A sketch 

 
ABD company ltd wants to start drawing a new products by using SolidWorks software, 

As professional SolidWorks user you are asked to select default planes and create a 

custom plane for complying to the design.  

Application of learning 2.1. 
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Indicative content 2.2: Creating Sketch 

  

 
1: Read and answer the following questions: 

i. What do you understand by the following terms 2D sketch in SolidWorks? 

ii. Identify the key Elements of a Sketch. 

iii. Describe sketch tools and sketch entities in SolidWorks? 

iv. Discuss on sketch relations in SolidWorks? 

v. Describe sketch status  in SolidWorks? 

2:  Write your findings on papers/flipcharts. 

3:  Present your findings. 

4: Pay attention on trainer’s clarifications and ask questions if any. 

5:  For more clarification, read the key readings 2.2.1 in trainee manual 

Key readings 2.2.1.: Description  of sketch   

● 2D sketch  

When creating parts in SolidWorks, 2D sketches are used as the foundation for 

defining the shapes and features of the part 's geometry. A 2D sketch is the 

starting point for creating a part in SolidWorks. It is a 2-dimensional 

representation of the part's geometry and features. You can create a 2D sketch 

on a selected plane or face of the part.  

There are various ways of creating a sketch. All sketches include the following 

elements: Origin plane and sketch entities 

✔ Origin: In many instances, you start the sketch at the origin, which 

provides an anchor for the sketch.   

 
 

Duration: 6hrs 

 

 

Theoretical Activity 2.2.1: Creation of Sketch  

Tasks: 
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✔ Sketch entities  

SolidWorks provides a variety of sketch tools to help you create and 

modify your sketches. These tools include lines, arcs, circles, rectangles, 

splines, Move Entities, Rotate Entities , Offset Entities and more. You can 

use these tools to sketch the desired shape and dimensions of your part. 

Specifically sketch entities are used to edit or modify design intent. 

 

Icons Name 

 Construction Geometry 

 Text 

 Plane 

 Sketch Fillet 

 Sketch Chamfer 

 Offset Entities 

 Offset On Surface 

 Convert Entities 

 Intersection Curve 

 Face Curves 

 Segment 

 Trim Entities 

 Extend Entities 

 Split Entities 

 Mirror Entities 

 Dynamic Mirror Entities 

 Move Entities 

 Rotate Entities 

 Scale Entities 

 Copy Entities 

 Replace Entity 

 Stretch Entities 

 Linear Sketch Pattern 

 Circular Sketch Pattern 

 Make Path 

 Modify Sketch 

https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_Construction_Geometry.htm#mhg1450446537562
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_Sketch_Text.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/HIDD_DVE_CREATE_PLANE_NEW.htm#okm1450446537947
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_Sketch_Fillets.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_Sketch_Chamfers.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_Offset_Entities.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Creating_Sketch_offsets_on_3D_Geometry_Surfaces.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_Convert_Entities.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_Intersection_Curves.htm#mgw1450446538823
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_Face_Curves.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_equidistant_points_and_segments.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_Trim_Entities.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Extend_Entities.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_split_entities.htm#nij1450446539827
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_Mirror_Entities.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/HIDD_DVE_SKETCH_DYNAMIC_MIRRORING.htm#zlx1450446540260
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Moving_or_Copying_Sketch_Entities.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Rotating_Sketch_Entities.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Scaling_Sketch_Entities.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Moving_or_Copying_Sketch_Entities.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_replace_sketch_entities.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Stretching_Sketch_Entities.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Creating_Linear_Sketch_Patterns.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Creating_Circular_Sketch_Patterns.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_Make_Path.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/HIDD_MODIFY_SKETCH.htm
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 No Solve Move 

 Sketch Picture 

 Sketch Numeric Input 

 Sketch Dimension Driven 

 Add Dimension 

 

✔ Sketch Tools 

Sketch tools are the basic sketch creation tools that used to create a new 

sketch. They include lines, arcs, circles, ellipses, polygon and Smart 

dimension. You can combine and manipulate these entities to create 

complex shapes and features.  

 

Icons Name 

 
Select 

 

Grid/Snap 

 
Sketch or Exit Sketch 

 
3D Sketch 

 
3D Sketch On Plane 

 Slicing 

 Rapid Sketch 

 Instant2D 

 Shaded Sketch Contours 

 Line 

 Corner Rectangle 

 Center Rectangle 

 3 Point Corner Rectangle 

 3 Point Center Rectangle 

 Parallelogram 

 Straight Slot 

 Centerpoint Straight Slot 

 3 Point Arc Slot 

 Centerpoint Arc Slot 

https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Using_No_Solve_Move.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_Sketch_Picture.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_numeric_sketch_input.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Inserting_Reference_Dimensions.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Displaying_Dimensions.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_Select.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/HIDD_OPTIONS_GRID.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_sketching_sketch_entities_tool.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Exiting_Sketches.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Beginning_a_3D_Sketch.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/HIDD_DVE_SKETCH_3D_PLANE.htm#njz1450446538011
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_slicing_tool.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Using_RapidSketch.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Modifying_2D_Sketch_Dimension_Instant2D.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Extruding_Shaded_Sketch_Contours.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketching_Lines.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketching_Corner_Rectangles.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketching_Center_Rectangles.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketching_3_Point_Corner_Rectangles.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketching_3_Point_Center_Rectangles.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketching_Parallelograms.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketch_Creating_Straight_Slot.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketch_Creating_Centerpoint_Straight_Slot.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketch_Creating_3_Point_Arc_Slot.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketch_Creating_Centerpoint_Arc_Slot.htm
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 Polygon 

 Circle 

 Perimeter Circle 

 Center point Arc 

 Tangent Arc 

 3 Point Arc 

 Ellipse 

 Partial Ellipse 

 Parabola 

 Conic 

 Spline 

 Style Spline 

 

✔ Sketch relations  

Sketch relations are used to define the geometric relationships between sketch 

entities. They ensure that the sketch maintains its intended shape and 

dimensions. Examples of sketch relations include horizontal/vertical alignment, 

tangency, symmetry, concentricity, and parallelism.  

 
The green  symbols indicate that there is an equal relation between the horizontal 

lines:  

https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketching_Polygons.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketching_Circles.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketching_Perimeter_Circles.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketching_Centerpoint_Arcs.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketching_Tangent_Arcs.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketching_3_Point_Arcs.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketching_Ellipses.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketching_Partial_Ellipses.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Sketching_Parabolas.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_Conics.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/t_Creating_Multiple_Point_Splines.htm
https://help.solidworks.com/2020/english/SolidWorks/sldworks/c_about_style_splines.htm
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✔ Status of a Sketch  

The status of a sketch refers to how well-defined the sketch is in terms of 

its geometry and dimensions.  Understanding the status of a sketch is 

important for maintaining control over the design and ensuring the 

accuracy and stability of the part. By properly defining the sketch with 

dimensions and relations, you can effectively control the shape and 

behavior of the part. In SolidWorks, the status of a sketch can be classified 

as fully defined, under defined, or over defined.  

 Fully defined: A fully defined sketch has all its dimensions and 

geometric relationships specified, leaving no degrees of freedom. 

This means that the sketch is completely constrained and its shape 

is fixed.  

 
 Under defined: An under defined sketch has some dimensions or 

geometric relationships that are not fully specified. This results in 

some degrees of freedom, allowing the sketch to change its shape 

or position. It is important to fully define a sketch to ensure its 

stability and accuracy.  

 
 Over defined: An over defined sketch has redundant or 

conflicting dimensions or geometric relationships. This can lead to 

errors or unexpected behavior in the sketch. It is necessary to 

remove the redundant constraints or dimensions to achieve a fully 

defined or under defined status.  
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1. Refer to the introduction perform the activity of the following task:  

As computer technician you are asked to select a front plane and create sketch 

from center point Straight Slot of 100 mmx80 mm  and after that make sure the 

sketch geometry is full defined. 

2. Read the steps from key reading 2.2.2 in Trainee’s manual. 

3. Pay attention on demonstration from trainer on how to create sketch in 

SolidWorks. 

4. Create sketch by simulating what you have seen from trainer‘s demonstration. 

5. Ask  for clarification if there is any occurred issue 

 

Practical Activity 2.2.2: Creating  Sketch 

 

Task: 
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Key readings 2.2.1 : Creating Sketch  

o Steps: 
1. Launch SolidWorks and create a new part file. 

2. Choose a plane (e.g., Front, Top, or Right)  

3. Click on the "Sketch" tab in the Command Manager, then select "Sketch" 

to enter sketch mode. 

4. Select the desired sketch tools (e.g., Line, Circle, and Rectangle) from the 

Sketch toolbar to create your geometry. 

5. Click on the workspace to place points, lines, or shapes.  

6. Apply Dimensions and Relations 

7. Modify sketch entities as needed by selecting and dragging them or using 

the properties toolbar. 

8. Click "Exit Sketch" to return to the part environment. 

9. Save the part file to ensure your sketch is retained. 

 

✔ 2D Sketch: 

● Starting point for part creation. 

● Represents the part's geometry in two dimensions. 

● Can be created on a selected plane or face. 

✔ Key Elements of a Sketch: 

● Origin 

● Plane 

● Sketch Entities 

✔ Sketch entities available for creating and modifying sketches: 

● Move Entities 

● Rotate Entities 

● Copy Entities 

Application of learning 2.1 

. 
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● Split Entities 

● Scale Entities 

● Offset Entities 

● Stretch Entities 

● Convert Entities 

● Trim Entities 

● Stretch Fillet 

● Mirror Entities 

● Make Path 

✔ Sketch Tools are tools that used for creating Basic geometric shapes include: 

● Line, Corner Rectangle, Center Rectangle, Parallelogram 

● Circle, Arc, Polygon, Spline, Text, Centerline, Midpoint Line… 

✔ Sketch Relations Examples: Horizontal/Vertical Alignment, Tangency, Symmetry, 

Concentricity, Parallelism. 

✔ Status of a Sketch: 

● Fully Defined 

● Under Defined 

● Over Defined 

✔ Rule of Thumb When Sketching: 

● Create a rough sketch. 

● Add relations to define relationships. 

● Add dimensions for accuracy. 

✔  You must know the steps of creating sketch in solidWorks: 

 

 

XZ Company needs a technician for creating sketches in SolidWorks at the beginning of 

their 3D design model of their new product. As a technician of Computer system and 

Architecture create a 2d sketch by using  sketch a Corner Rectangle, Center Rectangle, 

3 Point Corner Rectangle, and a 3 Point Center Rectangle width each one has width of 

20mm and length of 40mm. ensure that sketch status is fully defined and sketch relation 

are applied.  

Application of learning 2.4. 
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Indicative content 2.3: Applying Part Features 

  

 
1. In small groups discuss on the following questions: 

i. Discuss on the classification of  sketched feature and applied feaures in Solid 

Works? 

ii. Describe the different SolidWorks part feature tools ? 

iii. Highlight the examples of SolidWorks feature tool end conditions. 

2. Write the findings on paper or flip chart 

3. Present the findings/answers on paper/flip chart  

4. Pay attention on trainer’s clarifications and ask questions if there is any. 

5. For more clarification, read the key readings 2.3.1 in trainee manual 

Key readings 2.3.1: Description of SolidWorks feature tools 

 

● Features  can be classified as either sketched or applied.  

● Sketched Features: One that is based upon a 2D sketch  only this type can be 

used as a base feature.  

● Applied Features: Created directly on the solid model. Fillets and chamfers 

are examples of this type of feature. 

✔ SolidWorks Feature types are:  

● Basic features,  

● Modifying features and 

●  Pattern features 

✔ Basic Features types 

1) Extruded Boss: Projects a two dimensional sketch linearly to create a three 

dimensional part. Can be two directional and Creates a solid feature by extending 

a 2D sketch profile along a straight path.  

 

Duration: 5 hrs  

 

 

Theoretical Activity 2.3.1: Description of each SolidWorks feature tool 

Tasks: 
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2) Revolved Boss: Creates a solid feature by rotating a 2D sketch profile around an 

axis.  

 
3) Swept Boss: Creates a solid feature by sweeping a 2D sketch profile along a curved 

path.  

 
4) Lofted Boss: Creates a solid feature by connecting two or more 2D sketch profiles 

along a curved path.  

 
5) Extruded Cut: Removes material from a solid feature by extending a 2D sketch 

profile along a straight path.  

 
6) Revolved Cut: Similar to the revolve boss/base feature. Revolve cut takes a two 

dimensional sketch and revolves it about an axis to remove material from a 

preexisting part.  

 

✔ Modifying Features types 

1) Fillet: Rounds off sharp corners, or adds volume to the material by rounding off an 

inner corner. The user inputs the radius of the fillet. This feature does not require a 

sketch to use; only a preexisting part is needed.  

 
2) Chamfer can be found under the pull down arrow. This feature performs similarly 

except that it breaks the edges rather than rounds them.It Creates a beveled edge 

between two or more faces. 

3) Rib: An extrude feature created from open or closed sketch contours. The user 

specifies the desired thickness and the directional path between the sketch 

contour and the part/Creates a thickened feature that extends from one face to 

another.  

 
4) Shell: Creates a hollow feature by removing material from the outer surface of a 

solid.  
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✔ Pattern Features types 

1) Linear Pattern: Creates multiple instances of a feature arranged in a straight line. 

 
2) Circular Pattern: Creates multiple instances of a feature arranged in a circle. 

3) Mirror  : Creates a mirror image of a feature across a plane.  

 

✔ Examples of design intent in respect to End Conditions of features : 

● Blind  

● Through all  

● Mid-plane  

● Up to Next  

● Up to Surface 

 

 
 

1. Refer to the introduction of the activity you are asked to perform the following task: 

  As computer technician you are asked to create  25 CD storage box ,By following design 

criteria for a CD storage box ,Overall size for 10 CD storage box = 25cm x 12.4cm x 14.2cm 

The CD storage box is constructed of a polymer (plastic) material. 

2. Read the steps from key readings 2.3.2 in trainer manual  

3. Follow the demonstration from your trainer on how to apply some SolidWorks 

features 

4. Apply feature by simulating trainer what have shown in demonstration. 

5. Ask for support from your trainer if there is an occurred issue. 

 

Practical Activity 2.3.2: Applying part features 

Task:  
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Key readings 2.3.2: Applying part features 

 

● Applying part features 
✔ Extruded Boss/Base Steps  

1.Create a 2D sketch on a plane. 

2.Select the sketch and the "Extruded Boss/Base" command. 

3.Define the extrusion direction and depth. 

4.Set the end condition (blind, through all, up to next). 

5.Adjust other settings (draft, fillet, chamfer). 

6.Click "OK" to create the feature. 

✔ Revolved Boss Steps:  

1. Create a 2D sketch on a plane. 

2. Select the sketch, the "Revolved Boss" command, and the axis of rotation. 

3. Define the angle of rotation. 

4. Adjust other settings (draft, fillet, chamfer). 

✔ Swept Boss Steps:  

1. Create two 2D sketches on different planes. 

2. Select the sketches, the "Swept Boss" command, and the path. 

3. Adjust other settings ( fillet, chamfer). 

4. Click "OK" to create the feature 

✔ Lofted Boss Steps:  

1. Create multiple 2D sketches on different planes. 

2. Select the sketches, the "Lofted Boss" command, and the path. 

3. Adjust other settings (twist, draft, fillet, chamfer). 

4. Click "OK" to create the feature. 

● Applying modifying feature 

✔ Fillet Steps:  

1. Select the Fillet tool from the Features tab. 
2. Click on the edges or faces where you want to apply the fillet. 
3. Specify the radius of the fillet. 
4. Confirm the selection to create the fillet. 

✔ 6.Chamfer Steps: 

1. Select the Chamfer tool from the Features tab. 
2. Choose the edges to be chamfered. 
3. Set the chamfer type (distance and angle or two distances). 
4. Click to apply the chamfer. 
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✔ Rib Steps: 

1. Select the Rib tool from the Features tab. 
2. Create or select a 2D sketch for the rib profile. 
3. Specify the thickness and direction of the rib. 
4. Click to create the rib feature. 

✔ Shell Steps:    

1. Select the Shell tool from the Features tab. 
2. Choose the solid body you want to hollow out. 
3. Specify the wall thickness. 
4. Select faces to remove if necessary. 
5. Confirm to apply the shell feature. 

● Applying modifying feature 

✔ Linear Pattern Steps:    

1. Select the Linear Pattern tool from the Features tab. 
2. Choose the feature or body to pattern. 
3. Define the direction and spacing for the pattern. 
4. Specify the number of instances in each direction. 
5. Click to create the linear pattern. 

✔ Circular Pattern Steps:    

1. Select the Circular Pattern tool from the Features tab. 
2. Choose the feature or body to pattern. 
3. Select the central axis for the circular arrangement. 
4. Define the number of instances and angle between them. 
5. Click to apply the circular pattern. 

✔ Mirror Steps:    
1. Select the Mirror tool from the Features tab. 
2. Choose the features, faces, or bodies you want to mirror. 
3. Select the mirror plane (face or plane). 
4. Confirm to create the mirrored geometry. 
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✔ Trainees must know to create 2D sketch and apply feature  

✔ Trainees must know the following features Basic Features types 

● Extruded Boss 

● Revolved Boss 

● Swept Boss 

● Lofted Boss 

● Extruded Cut 

● Revolved Cut  

✔ Trainer muster know to modifying the exiciting featuire Features.  

 

 
AS computer peripherals technician, you've been hired to create a new model of an 

iPhone enclosure measuring 160.1mm x 77.9mm x 8.37mm and 12 mm of thichness 

.Finally, use different posible  SolidWorks feature tools that can be applied to design this 

enclosure.  

Points to Remember 

Application of learning 2.3 
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Indicative content 2.4: Applying Visualization 

  

 
1. Refer to the introduction of the activity in small groups you are asked to answer the 

following questions: 

i. Define visualization? 

ii. Describe different part visualization tools that are found in Solid Works 

iii. Specify the purpose of each part visualization tools? 

iv. Why is view orientation crucial when creating models in SolidWorks, and how can 

it affect the ease of navigation and clarity of presentations? 

v. How do different display styles, such as shaded ,wireframe, contribute to 

understanding a model’s geometry during the design process? 

2. Write your findings on papers/flipcharts. 

3. Present your findings on papers/flipcharts. 

4. Follow the expert view from trainer and ask clarification if there is any. 

5. Read the Key readings 2.4.1 in trainee manual. 

 

Key readings 2.4.1. Description of Visualization tools 

✔ Definition of Visualization 

Visualization refers to the process of creating realistic representations of 3D 

models or parts using various tools such as materials, appearances, lighting, and 

camera settings. The goal of visualization is to help users and stakeholders 

understand what a final product will look like, how it will behave under certain 

conditions, and how it will interact with its environment. 

● Visualization tools of SolidWorks : 

Duration: 3 hrs  

 

 

Theoretical Activity 2.4.1: Description of visualization tools 

Tasks: 
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1.Material 

✔ Definition: 

● Materials in SolidWorks represent the physical characteristics of the part, 

affecting both its appearance and physical properties such as strength, 

density, and thermal conductivity. 

✔ Purpose: 

● Visual Representation: The material determines the look of the part, 

including its color, texture, and reflectivity. 

● Physical Simulation: Materials are vital for accurate simulation in stress 

analysis, thermal performance, and other engineering evaluations. 

2. Appearance 

✔ Definition: 

● Appearance in SolidWorks defines the visual look of a part, including 

color, texture, and transparency, but does not affect physical properties 

like materials do. 

✔ Purpose: 

● Enhancing Visuals: Appearance allows you to adjust how a part looks 

without changing its physical attributes, useful for presentation and 

rendering. 

● Customizing Designs: It enables customization of the part’s surface finish, 

whether polished, rough, matte, or glossy. 

3. Scene and Environment 

✔ Definition: 

● A scene in SolidWorks includes backgrounds and lighting settings that 

affect how parts and assemblies are displayed in the viewport or during 

rendering. The environment sets the context in which your model is 

visualized. 

✔ Purpose: 

● Realistic Rendering: By applying different scenes, you can make your 

parts appear as if they are in real-world settings (e.g., studio lighting, 

outdoor scenes). 
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● Light Behavior: Environments influence how light interacts with your 

part, adding realism to the visualization. 

4. View Orientation 

✔ Definition: 

● View orientation controls how the part is positioned and viewed in the 

3D workspace. 

✔ Purpose: 

● Ease of Navigation: It allows you to switch between standard views 

like top, front, isometric, or custom views to examine the model from 

various angles. 

● Presentation: Proper view orientation is essential for creating clear 

and communicative drawings or presentations of the model. 

 

5. Display Style 

✔ Definition: 

● Display style refers to how the model is visually represented in terms of 

edges, lines, and shading. It includes modes like wireframe, shaded, and 

hidden lines visible. 

✔ Purpose: 

● Clear Visualization: Different display styles help in analyzing the model’s 

geometry, edge quality, and internal structure. 

● Technical Clarity: Useful for technical drawings where different 

representations are needed (e.g., hidden lines for assembly views). 

✔ Types of Display Styles: 

● Shaded: Fully shaded model with or without edges. 



53 | SolidWorks Designs–Trainee Manual 

● Wireframe: Only the edges of the model are visible. 

● Hidden Lines Removed/Visible: Displays the model with hidden lines either 

removed or shown. 

6. Lighting 

✔ Definition: 

● Lighting in SolidWorks simulates how light sources interact with the part, 

affecting how it is rendered in terms of brightness, shadows, and reflections. 

✔ Purpose: 

● Realistic Rendering: Proper lighting enhances the realism of rendered 

parts, highlighting details, surface finishes, and creating shadows. 

● Depth and Dimension: Lighting gives depth to parts, making them appear 

more three-dimensional and life-like. 

✔ Types of Lighting: 

● Ambient: General lighting that illuminates all parts evenly. 

● Directional: Simulates sunlight or other directed light sources. 

● Spotlight and Point Light: Focused lighting for detailed highlights. 

7. Camera Setting 

✔ Definition: 

● Camera settings allow you to create virtual cameras within the 

SolidWorks environment to define specific view angles, focal lengths, and 

perspective for visualizing the part. 

✔ Purpose: 

● Control Over Perspective: Cameras offer greater control over the 

perspective and depth of the scene, crucial for presentations, 

animations, and rendered images. 

● Customization: Different camera angles can simulate real-world 

photography setups for more professional renderings. 

8. Evaluate 

✔ Definition: 
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● The Evaluate tab in SolidWorks contains tools for analyzing the visual and 

physical properties of parts and assemblies. This includes evaluating 

mass, dimensions, and features. 

✔ Purpose: 

● Quality Check: Use the Evaluate tools to check model dimensions, mass 

properties, and other metrics to ensure design accuracy. 

● Rendering Previews: Evaluate visual properties before running a full render 

to check how the material, appearance, and lighting will look.  

 

 

 

1. Refer to the introduction you are asked to perform the following task: 

As computer technician you are asked to create CD storage box 17cm x 12.4cm x 

14.2cm  and use  visualization modes such as material, appearance, Scene and 

Environment, View orientation and Display style .The CD storage box is constructed of 

a polymer (plastic) material. 

2. Read the steps from key reading 2.4.2 in trainee’s manual 

3. Follow trainer’s demonstration on how to apply visualisation by using some visualisations 

tools. 

4.Simulate how to apply visualisation in SolidWorks Software by referring to assigned task. 

5. Ask for clarification related to the any occurred issued. 

 

Key readings 2.4.2: Applying visualization 

1. Material 

✔ Steps to Apply: 

1) Right-click the part in the Feature Manager. 

2) Select Material > Edit Material. 

3) Choose the desired material from the library (e.g., steel, aluminum, plastic). 

4) Click Apply to assign the material properties. 

 

Practical Activity 2.4.2: Applying visualization 

 

Task: 
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2. Appearance 

✔ Steps to Apply: 

1) Right-click the part or face in the graphics area. 

2) Select appearance from the context menu. 

3) Choose a preset appearance (e.g., polished metal, matte plastic, wood) or customize 

it with colors and textures. 

3.How to Use View Orientation: 

Click the View Orientation icon or press the space bar > Choose standard views or create a 

custom view. 

4.How to Adjust Lighting: 

Go to Scene settings > Edit Lights > Adjust light intensity, position, and type. 

5.Scene and Environment : 

✔ Steps to Apply: 

1) Go to the Scene, Lights, and Cameras tab in the task pane. 

2) Right-click Scene and choose Edit Scene. 

3) Select a preset scene (e.g., studio, outdoor, or indoor environment) or customize it 

by adding your own background images and lighting. 

4) Adjust the environment rotation and floor reflection for better visualization.  

6. View Orientation 

✔ Step to Apply: 

1) Click the View Orientation button in the heads-up toolbar or press the spacebar. 

2) Choose from preset views (e.g., Isometric, Front, Right ) or create a custom 

orientation by manually rotating the model. 

3) Save the custom orientation for later use if needed. 

7.Display Style 

✔ Steps to Apply: 

1) Select the Display Style dropdown from the heads-up toolbar. 

2) Choose from options like Shaded with Edges, Wireframe, Hidden Lines Removed, or 

Hidden Lines Visible. 
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8. Lighting 

✔ Steps to Apply: 

1) Go to the Scene, Lights, and Cameras tab in the task pane. 

2) Right-click Lights and choose Add Light or Edit Light. 

3) Adjust the type (e.g., ambient, directional, spot), intensity, and position of lights. 

4) You can also enable/disable certain lights to create the desired visual effect. 

9. Camera Setting 

✔ Steps to Apply: 

1) Go to the Scene, Lights, and Cameras tab. 

2) Right-click Cameras and select Add Camera. 

3) Position the camera and set its orientation, field of view (zoom), and depth of field. 

4) You can switch to Camera View to see how the model looks from the camera’s 

perspective. 

10. Evaluate 

✔ Steps to Apply: 

1) Go to the Evaluate tab in the command manager. 

2) Tools available include Mass Properties, Section View, Interference Detection, Draft 

Analysis, and Measure. 

3) Use these tools to analyze weight, check for interference in assemblies, or measure 

critical dimensions. 

  

 
● Visualization tools : 

✔ Material 

✔ Appearance 

✔ Scene and Environment 

✔ View Orientation 

✔ Display Style 

✔ Lighting 

✔ Camera Setting  

✔ Evaluate 

Points to Remember 
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● Trainee must know the steps of  using SolidWorks Software Visualization tools 

 

As a technician in Computer Systems and Architecture, you are hired to design a CD 

storage box with dimensions of 54.0 cm in width, 16.4 cm in height, and 17.2 cm in 

depth. By using SolidWorks, you'll apply visualization techniques on a pre-made part file 

to enhance your design. This includes applying materials, customizing the appearance, 

and editing the scene with appropriate backgrounds and lighting. You'll also adjust view 

orientations to analyse the model from various angles and explore different display 

styles. Finally, you will use evaluation tools to assess mass properties and dimensions, 

emphasizing the importance of effective visualization in the design process.  

Application of learning 2.4 
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Indicative content 2.5:Exporting Part 

 

 

1. After forming small groups  you are asked to answer following questions:  

i. what is export part in SolidWorks 

ii. What are the purpose for exporting parts from SolidWorks? 

iii. What are the most common file formats supported for exporting parts from 

SolidWorks? 

iv. What are the standard file formats supported for exporting parts from 

SolidWorks? 

2. Write your findings on papers/flipcharts  

3. Present your findings/ answers 

4. Pay close attention to the expert view from trainer 

5. Ask for clarification related to the any occurred issue .   

 

Key readings 2.5.1. Description of part export in SolidWorks 

✔ Definition 

● Exporting a Part in SolidWorks refers to the process of saving a part or assembly 

model in a different file format than the native SolidWorks format (.sldprt for parts, 

.sldasm for assemblies) so that it can be used in other applications or shared with 

others.  

● Exporting in SolidWorks involves saving a part or assembly in a different file format 

for use in other applications or for sharing with others. 

✔ Purpose 

● Facilitate collaboration with team members who may use different software. 

● Prepare files for manufacturing, presentation, or documentation. 

Duration:3hrs.  

 

 

Theoretical Activity 2.5.1: Description of part export in SolidWorks 

Tasks: 
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● Ensure compatibility with various file formats as required by clients or project 

specifications. 

✔ File format 

● A file format defines how data is structured and stored within a file. 

● Choosing the correct format ensures compatibility with SolidWorks and other 

software. 

● SolidWorks provides various file formats for exporting parts, such as prt, sldprt, 

STEP, IGES, STL, and more. The file format you choose depends on the intended 

use and compatibility requirements of the exported file.  

● Common SolidWorks Export Formats: 

✔ .SLDPRT (SolidWorks Part):Native file format for parts in SolidWorks. It preserves 

all the parametric design information for further editing in SolidWorks. 

● Use: For continuing work within SolidWorks. 

.STL (Stereolithography):A mesh format that converts 3D models into triangles, 

commonly used for 3D printing. 

● Use: Ideal for 3D printing, as it simplifies the model into a format printers can read. 

✔ .STEP / .STP (Standard for the Exchange of Product Data):A neutral, widely-used 

format for sharing CAD data across different software platforms. 

● Use: Useful for sharing detailed 3D models with other CAD systems without losing 

design integrity. 

✔ .IGES / .IGS (Initial Graphics Exchange Specification):Another neutral file format 

used for exchanging CAD models, especially surface models. 

● Use: For transferring both 2D and 3D CAD data between different software 

platforms. 

✔ .PDF (Portable Document Format):A 2D format for sharing drawings, allowing 

others to view or print without needing CAD software. 

● Use: Best for distributing technical drawings or documents for review or printing. 

✔ .DXF /.DWG: Standard formats for exchanging 2D drawings and technical designs, 

often used in AutoCAD. 

● Use: Common in CNC machining, laser cutting, and when transferring 2D data to 

other design programs. 

✔ .Parasolid (.X_T):A format used for exchanging precise geometric models between 

different 3Dmodeling software. 

● Use: For ensuring accurate data transfer between different CAD systems that 

support Parasolid files. 
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✔ File location: When exporting a part in SolidWorks, you can choose the desired file 

location where you want to save the exported file. This can be a local folder or a 

network location.  

✔ Methods for Backing Up SolidWorks Files: 

● Manual Backups: Periodically copy files to external drives or different folders. 

● Automatic Backups: Utilize software that automates backups at scheduled 

intervals. 

✔ Differences Between Network Drives and Local Storage: 

● Network Drives: Accessible from multiple devices within a network, ideal for 

collaborative work environments.( Cloud storage options (e.g., Google Drive, 

Dropbox, OneDrive) provide remote access, easy sharing, and automatic 

backup solutions. 

● Local Storage: Files are stored on a single device, allowing for faster access but 

limited to that machine. 

 
 

1 :After forming small groups  you are requested to perform the following task  

As technician from computer peripheral manufacturing company you are requested to 

redraw the image below without considering scale and its real size and export it to jpg 

and pdf 

 
2: Read the steps from key reading 2.5.2 in trainee manual  

3:  Pay attention to trainer’s demonstration 

4:  Export part by following the steps demonstrated by trainer 

5:  In addition, ask questions where necessary. 

  

 

Practical Activity 2.5.2 Exporting Part  

Task: 
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Key readings 2.5.2 .Exporting Parts Using SolidWorks Software 

Steps to Export a Part : 

1. Start SolidWorks and open the part file you wish to export. 

2. Go to File Menu and Click on File in the menu bar. 

3. Choose Save As from the dropdown menu. 

4. Choose Export Format In the "Save as type" dropdown menu, select the desired file 

format (e.g., .STEP, .IGES, .STL). 

5. Enter a file name and choose the destination folder. 

6. Click on the Options button to configure settings specific to the chosen format (e.g., 

exporting solid bodies, surfaces, mesh quality for .STL). 

7. Click Save to complete the export process. 

8. Exporting Options 

 
● While exporting a Part in SolidWorks  trainee must know the steps to be used. 

File Format 

● .SLDPRT for SolidWorks parts 

● .STL for 3D printing 

● .STEP or .IGES for CAD data exchange 

● .PDF for 2D drawings 

● .DXF/DWG for 2D drawings and CNC 

● .Parasolid (.X_T) for CAD compatibility  

Points to Remember 
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As technician from computer peripheral manufacturing company you are requested to design 

the image below without considering scale and its size real size an export to STEP or .IGES for 

CAD data exchange. 

  

Application of learning 2.5. 
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Learning outcome 2 end assessment 

 

 
Part I.Match the file format with its correct description: 

1) .SLDPRT stands for the following: 

a) A mesh format used for 3D printing 

b) Native file format for parts in SolidWorks 

c) Standard format for exchanging 2D drawings 

 

2) . STL stands for: 

a) A 2D format for sharing drawings 

b) Converts 3D models into triangles, commonly used for 3D printing 

c) A neutral format for CAD data exchange 

 

3..STEP / .STP  stands for: 

a) Neutral format for sharing 3D CAD data across different platforms 

b) Used for distributing technical drawings 

c) Converts 3D models into mesh for printing 

 

4..IGES / .IGS stands for: 

a) Standard format for exchanging 2D drawings and technical designs 

b) Used for transferring both 2D and 3D CAD data between platforms 

c) Used for editing parametric models in SolidWorks 

 

5).PDF stands for: 

 

 a) A 2D format for sharing technical drawings 

b) A neutral format for CAD data exchange 

c) A format used in CNC machining 

 

6).DXF / .DWG stands for: 

 

a) A format used for exchanging precise geometric models 

b) Neutral format used for surface models 

c)  Standard formats for exchanging 2D drawings 

 

PART II 

1. What does the "Extruded Boss" feature do in SolidWorks? 

Written  assessment  
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A) Removes material by extending a 2D sketch along a curved path 

B) Projects a 2D sketch linearly to create a 3D part 

C) Connects two sketches along a curved path to create a solid feature 

D) Rotates a 2D sketch around an axis to create a solid feature 

2. Which feature creates a solid by rotating a 2D sketch profile around an axis? 

A) Swept Boss 

B) Extruded Cut 

C) Revolved Boss 

D) Lofted Boss 

3. What is the primary function of the "Chamfer" feature? 

A) Rounds off sharp corners 

B) Creates a beveled edge between two or more faces 

C) Removes material from the outer surface of a solid 

D) Copies a feature in a circular pattern 

4. Which feature removes material by revolving a 2D sketch around an axis? 

A) Revolved Cut 

B) Revolved Boss 

C) Extruded Boss 

D) Lofted Cut 

5. Which feature is used to hollow out a solid by removing material from the outer 

surface? 

A) Fillet 

B) Shell 

C) Rib 

D) Swept Boss 

6. Which pattern feature arranges multiple instances of a feature in a straight line? 

A) Circular Pattern 

B) Mirror 

C) Linear Pattern 

D) Lofted Boss 

7. Which of the following is NOT a standard plane in SolidWorks? 
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A) Front plane 

B) Top plane 

C) Left plane 

D) Right plane 

8. How can you create a custom plane in SolidWorks? 

A) Use the "Sketch" tab and select "Plane" 

B) Go to the "Features" tab, click "Reference Geometry," and select "Plane" 

C) Select an edge and use the "Extrude" feature 

D) Open the "Insert" tab and click on "Custom Plane" 

9. What is the purpose of a custom plane in SolidWorks? 

A) To define a new surface on which sketches and features can be created 

B) To rotate an object in the assembly 

C) To apply material properties to a part 

D) To add dimensions to a model 

10. Which of the following is NOT a valid reference for creating a custom plane in 

SolidWorks? 

A) A face 

B) A plane 

C) A point 

D) A dimension 

11. When creating a custom plane, what can you use to define its orientation and 

position? 

A) Only existing planes 

B) Any reference entity such as a face, edge, or point 

C) Only reference points 

D) Coordinate system only 

12. What step comes immediately after selecting "Plane" from the "Reference Geometry" 

menu when creating a custom plane? 

A) Click "OK" to create the custom plane 

B) Choose the reference entities to define the plane's location and orientation 

C) Specify the plane's material properties 

D) Define the plane's color 

Part III. 

Question1: What is the primary purpose of visualization in 3Dmodeling? 

A) To create physical simulations 
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B) To assist in technical drawings 

C) To help users understand how a product will look, behave, and interact with its 

environment 

D) To calculate mass and dimensions 

Question2: Which of the following best describes the purpose of assigning materials in 

3Dmodeling? 

A) To change the visual appearance only 

B) To simulate physical properties like strength and density and affect visual appearance 

C) To control the lighting setup 

D) To create camera perspectives 

Question3: What is the main difference between material and appearance in 3Dmodeling? 

A) Material changes the physical properties, while appearance changes only the visual look 

B) Appearance affects the lighting, and material affects transparency 

C) Material affects the background, and appearance adjusts camera settings 

D) Material is for animations, and appearance is for rendering 

Question4: What is the main purpose of defining a scene and environment in 3D rendering? 

A) To change the visual appearance of materials 

B) To control how the part interacts with light and create realistic backgrounds 

C) To adjust the dimensions of the part 

D) To evaluate the mass of the object 

Question5: Why is view orientation important in 3Dmodeling? 

A) It controls how light interacts with the part 

B) It adjusts the physical properties of the material 

C) It positions the part in 3D space for better navigation and presentation 

D) It changes the visual appearance of the part 

Question6: Which of the following options refers to a display style that uses shading and 

edges to represent a model? 

A) Wireframe 

B) Shaded 

C) Transparent 

D) Texture-mapped 

Question7: How does lighting affect a 3D rendering? 

A) It controls the camera’s perspective 

B) It simulates light interaction, impacting brightness, shadows, and reflections 

C) It alters the material properties 

D) It changes the object's mass 

Question8: What is the purpose of adjusting camera settings in a 3D scene? 

A) To change material properties 

B) To control the lighting setup 
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C) To create specific view angles and perspectives for presentations 

D) To simulate physical properties 

Question9: Which tool is used to assess the physical and visual properties of a 3D model? 

A) Appearance 

B) Scene setup 

C) Evaluate 

D) Display style 

 

  

As computer system technician you have been tasked with designing a custom 

motherboard tray for a high-end computer chassis. The tray will need mounting points 

for a variety of components and will be made of aluminium. You will create the part in 

SolidWorks, visualize it, and export it for both 3D printing and CNC machining.  

Practical assessment 
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Learning Outcome 3: Assemble parts  
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Indicative contents 
3.1. Importing components/inserting components. 

3.2. Applying mates 

3.3.  Exporting assembly 

Key Competencies for Learning Outcome 3: Assemble parts 

Knowledge  Skills  Attitudes  

● Description of 

components 

● Definition of mates 

based on their types 

● Identification of  file 

format 

● Importing 

components/inserting 

components 

● Making assembly from 

a part 

● Browsing components 

● Applying mates 

● Exporting Assembly 

● Having Passion  

● Having Adaptability 

● Having Critical thinking 

capabilities 

● Having Creativity 

● Being Problem Solver  

● Being Decision Maker  

● Being a Team worker  

 

 

Duration10 hrs  

Learning outcome 3 objectives:   

By the end of the learning outcome, the trainees will be able to:  

1. Import correctly components as related to the assembly template. 

2. Importing correctly Non-SolidWorks Parts (External Formats) In SolidWorks. 

3. Differentiate types of mates related to the assembly template. 

4. Identify different types of file format compatible with SolidWorks. 

5. Make correct assembly from part template. 

6. Export properly assembly from part template 
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Resources 

Equipment   Tools  Materials   

✔ Computer 

✔ Projector 

●    

✔ Storage media devices 

✔ SolidWorks software 

 

 

✔ Electricity 

✔ Internet connectivity 
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Indicative content 3.1:Importing components/inserting components. 

  

 

1 : Refer to the introduction provide the answers on the following questions: 

i. What do you understand by the assembly from a part in SolidWorks? 

ii. Describe computer components that can be imported or inserted in SolidWorks? 

iii. What do you understand by existing Part or Assembly in SolidWorks? 

iv. What do you understand by the term browsing components in SolidWorks? 

2: Provide the answer on papers/flipcharts. 

3: Present your findings  

4: Follow an expert view from trainer and ask clarification . 

5: For further understanding read the Key readings 3.1.1 in trainee manual 

 

Key readings 3.1.1.: Description of Importing Components/Inserting 

Components 

● Definition 

✔ Importing Components in SolidWorks refers to the process of bringing 

external 3D model files or part files into a SolidWorks assembly environment. 

This feature allows designers and engineers to integrate pre-existing parts or 

assemblies from various file formats into their current design project, 

facilitating collaboration and enhancing design efficiency. 

● Make assembly from a part: If you have already created a part and want to make an 

assembly from it, you can use the "Make Assembly from Part" feature. This allows 

you to convert the part into an assembly and add other components to it.  

● Selection of Component Part /Assembly  

In SolidWorks, the Selection of Component Part/Assembly refers to the process of 

choosing parts or assemblies to work with in a design project. SolidWorks allows you 

to create both individual parts and assemblies of multiple parts, 

Duration: 1 hrs  

 

 

Theoretical Activity 3.1.1: Description on importing components. 

Tasks: 
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● Browsing components: When inserting components, you can browse for the desired 

components using the file browser. You can navigate through folders, search for 

specific file names, and preview the components before inserting them into the 

assembly. By importing and inserting components, you can build the assembly by 

bringing together the individual parts and creating the desired structure. This allows 

you to visualize the interaction and relationships between the components and 

ensure a proper fit and assembly.  

 

1 :Refer to the introduction you are requested to perform the following task 

As a technician you are asked to insert a designed mother board, RAM and Import any other 

components l to be assembled in SolidWorks?  

2: Read the key reading 3.1.2 in trainee’s manual 

3: Pay close attention to how the trainer demonstrates each step for inserting components. 

4: Follow along as the trainer demonstrates the steps for inserting components. 

5: Ask for Clarification if any 

 

Key readings 3.1.2: Importing Components/inserting Components 
Steps for inserting components: 

Step 1: Open SolidWorks  

Step 2: Select assembly Template 

 
 

Step 3: Select first component/part from the location where it is saved then click open 

 

Practical Activity 3.1.2: Importing components 

Task: 
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Step 4 : Open the Insert Component Tool and go in the Command Manager, click on the 

Assembly tab(to insert other parts/components). 

 
 

Step 5:Select Insert Components then, choose component that you want from its location 

and click on Open 
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Steps 6: Position your component/part 

 
  

Step 7: Insert a Component from File go In the Insert Components window, click Browse 

and Navigate to the location where the part is saved (e.g., a previously created part or a 

part from another source) then Select the part file (SolidWorks Part file format, typically 

.SLDPRT) and after that click open . 
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Step 8 : Place the Component and After selecting the part/component, click anywhere in 

the workspace to place the component. 

Importing Non-SolidWorks Parts (External Formats) in Solid works assembly template: 

Importing External CAD Files  you go to File > Open, and in the file type dropdown, select 

the appropriate file format (e.g., STEP Files (.STEP;.STP)). 

● Import Options and click the Options button in the file dialog to configure import 

settings, such as whether to import features or treat the imported file as a "dumb" 

solid (a single, non-editable geometry). 

● Insert into Assembly and once imported, you can insert the external component 

such like any other part by using the Insert Components tool in the Assembly. 

● Save the Assembly and inserting and positioning your components, save your 

assembly by going to File > Save. 

● Then Name your assembly and choose the desired save location. 

● Apply positioning and mating Components 

 

 

✔ Trainee must know the steps of importing part components and non solid 
components. 

  

Points to Remember 



77 | SolidWorks Designs–Trainee Manual 

 

As technician electronic devices company, You are requested to make an assembly in 

SolidWorks for a new electronic device that includes both SolidWorks parts and external 

CAD components. Task is to import and place various components of the electronic device 

in the assembly workspace, ensuring proper placement of parts.  

Application of learning 3.1. 
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Indicative content 3.2: Applying mates 

 

  

 

 
 
1 :Refer to the introduction you are asked to answer following questions:  

i. Describe the types of mates are used in SolidWorks? 

ii. Specify the purpose of each mate type as found in SolidWorks? 

iii. Identify the examples to each type of mate as found in SolidWorks? 

2: Provide the answers on papers/flipcharts 

3: Present your findings  

4: Follow an expert view from trainer and ask clarification . 

5: For further clarification ask question if any 

Key readings 3.2.1.: Description of mates are used in SolidWorks  

✔ Definition and application of different types of mates: 

● In SolidWorks, mates are used to define relationships between components in an 

assembly, controlling how parts move relative to each other. They can be 

categorized into different types based on complexity and function: 

1. Standard Mates 

● Standard mates are the most basic and commonly used mates. They define simple 

geometric constraints between parts. 

Types of Standard Mates: 

● Coincident: Aligns two faces, edges, or points so that they lie on top of each other. 

● Parallel: Forces two faces, edges, or planes to remain parallel to each other. 

● Perpendicular: Makes two entities perpendicular to one another. 

● Distance: Creates a fixed distance between two points, edges, or faces. 

● Angle: Constrains two entities to remain at a specific angle. 

● Concentric: Aligns two circular or cylindrical faces along a common axis. 

Duration: 8hrs  

 

 

Theoretical Activity 3.2.1:  Description of mates in SolidWorks 

Tasks: 
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● Tangent: Keeps two curved faces in contact at a single point, typically used with 

cylinders or spheres. 

Standard mates are used for basic assembly tasks like fixing, rotating, or aligning parts. 

2. Advanced Mates 

● Advanced mates provide more complex control over part movement and 

relationships. They offer specialized constraints for precise mechanical design. 

✔ Types of Advanced Mates: 

● Symmetric: Keeps two components symmetric relative to a plane or axis. 

● Width: Centers one component between two others, maintaining equal spacing on 

both sides. 

● Path Mate: Constrains a component to move along a predefined path (e.g., a 

sketch). 

● Linear/Distance Limit: Sets limits on how far two components can move relative to 

each other along an axis. 

● Angle Limit: Constrains the rotation of components to within a specific range of 

angles. 

 

✔ Application: Advanced mates are used when more control over movement is 

needed, such as limiting rotations or ensuring symmetry. 

3. Mechanical Mates 

● Mechanical mates simulate real-world mechanical relationships, such as gears or 

cam followers, allowing for realistic mechanical motion in assemblies. 

✔ Types of Mechanical Mates: 

● Cam: Allows a follower component to move in contact with a cam component, 

simulating cam-follower motion. 

● Gear: Simulates the relationship between two gears by ensuring that the rotation 

of one component drives the rotation of another. 

● Rack and Pinion: Simulates the interaction between a linear component (rack) and 

a rotating component (pinion), converting rotational motion into linear motion. 

● Screw: Constrains rotational motion and translates it into linear motion, simulating 

the behavior of a screw and nut. 

● Hinge: Restricts motion to rotation around a single axis, simulating a hinge joint. 

● Slot: Constrains one component to slide within a slot, mimicking slot-pin 

mechanisms. 

● Universal Joint: Simulates the behavior of a universal joint, allowing two 

components to rotate relative to each other at variable angles. 

✔ Note that: Mechanical mates are ideal for simulating specific mechanical 

interactions, making them useful for assemblies that have motion like gears, cams, 

and screws.  
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4. Mates for Analysis 

● These mates are primarily used for motion analysis, where you want to evaluate 

how parts move and interact under certain conditions. While not technically a 

separate category, they play a key role in dynamic simulations. 

✔ Function in Analysis: 

● Mates like Distance and Angle Limit are used in simulations to limit movement. 

● Mechanical mates are frequently used in kinematic analysis to simulate real-

world interactions. 

● Path Mate and Linear/Angular Limit can also help study the motion and 

restrictions of mechanical systems. 

 
● These mates are applied in motion studies or FEA (Finite Element Analysis) to 

analyse how parts behave under operational or stress conditions. 

 

 

1. Read the following task and perform the activity: 

i. Refer to the details of the SolidWorks Parts like Laptop Base is a 300mm to 200mm 

as part component with slots for ports and ventilation, The Laptop Screen is a 

300mm by 180mm display panel with a hinge mechanism that connects to the base. 

A task is to import all components both base and laptop screen then ensure that all 

laptop components are imported and assembled. 

ii. Imagine you are designing a new telephone with two sections: a keypad and a 

touchpad. 

 

Practical Activity 3.2.2: Applying mates 

 

Task: 
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Make sure to apply mates that allow the phone to fold and unfold while still 

functioning with one of its sections. Be sure to use both mechanical and standard 

mates to achieve this functionality. 

2. Read the key reading 3.3.2 in trainee’s manual. 

3. Pay close attention to how the trainer demonstrates each step for applying mates. 

4. Follow along as the trainer demonstrates the steps for inserting components. 

5. For further clarification, ask question if there is any. 

Key readings 3.2.2: Applying mates  

✔ Steps to Apply Standard Mates in SolidWorks: 

Step 1: Open the Assembly 

Step 2: Activate Mate Tool 

 
Step 3: Select the Entities to Mate (face, edge, vertex, or axis) of the second component 

that you want to mate with the first one. 

Step 4: Choose the Mate Type >Once both entities are selected, (Coincident, Parallel, 

Perpendicular and Specify a fixed distance and angle between the two selected entities. 

Step 5: Adjust Mate Settings and alignment direction if necessary and preview to ensure 

it behaves as expected. 

Step 6: Confirm the Mate  

Step 7: Add More Mates (if needed) by Repeating  

Step 8: Exit the Mate Tool 

Note that:  

● Once all required mates are applied, click the OK button to exit the Mate 

command. 

● Test the assembly by dragging components to ensure that the mates behave as 

intended. 

● For example: If you want to align two cylindrical parts: 
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1. Select the circular edge of the first part. 

2. Select the circular edge of the second part. 

3. Choose the Concentric mate. 

4. SolidWorks will align the two parts along their axes. 

  

 

● Types of mates 

1. Standard Mates 

2. Advanced Mates 

3. Mechanical Mates 

4. Mates for Analysis 

● You must know the steps to Apply Standard Mates in SolidWorks 

 

As a technician in a computer peripheral manufacturing company, you are tasked with 
designing a new motherboard model. The motherboard will feature various components, 
such as a heat sink, processor, memory modules, capacitors, fan, and resistors. Ensure 
that each component is properly connected and aligned to create a functional assembly 
of the motherboard, with special focus on the heat sink and capacitors for optimal 
performance and cooling. 

  

Points to Remember 

Application of learning 3.2 
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Indicative content 3.3: Exporting Assembly 

  

 

1. After forming small groups, answer the following questions: 

i. In SolidWorks, when exporting an assembly or part, why is it important to 

choose the correct file format ? 

ii. How does selecting the appropriate file location impact the workflow in terms 

of collaboration, version control, and accessibility? 

2. Provide the answers on paper/flipchart. 

3. Present your findings. 

4. Follow an expert view from trainer and ask clarification. 

5. For further clarification, Read the Key readings 3.3.1 in trainee manual. 

Key readings 3.3.1.:Exporting an Assembly in SolidWorks 

● Exporting assembly  

✔ Exporting an assembly refers to the process of saving a complete assembly file, 

which includes all its individual components and their relationships, into a 

different file format suitable for use in other software or for specific applications. 

This process allows the assembly to be shared, modified, or utilized in various 

contexts, such as manufacturing, 3D printing, or collaboration with other design 

tools. 

✔ File format: SolidWorks offers various file formats to export assemblies. An 

assembly is a collection of related parts saved in one SOLIDWORKS document file 

with “.sldasm” extension. The other common file formats for exporting 

assemblies include:  

● STEP (.stp): This is a widely used file format for exchanging 3D models 

between different CAD software. It provides a neutral format that 

preserves the geometry and structure of the assembly.  

● IGES (.igs): IGES is another standard file format for exchanging 3D models. 

It allows for the transfer of geometry information between different CAD 

systems.  

● Parasolid (.x_t or .x_b): Parasolid is a 3D modeling kernel used in many 

CAD systems.  

Duration:1hrs  

 

 

Theoretical Activity 3.3.1:  Description on exporting an Assembly in SolidWorks 

Tasks: 
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● STL (.stl): STL is a file format commonly used for 3D printing. Exporting an 

assembly in STL format creates a mesh representation of the assembly 

suitable for 3D printing applications.  

● PDF (.pdf): If you need to export the assembly for documentation or 

viewing purposes, you can choose to export it as a PDF file.  

✔ File location: When exporting an assembly, you need to specify the file location 

where you want to save the exported file. Choose a location on your computer 

or network where you can easily access the file later.  

✔ Know that: Selecting the right file location in SolidWorks greatly affects 

workflow by enhancing collaboration, version control, and accessibility. 

● Collaboration: Shared or cloud-based storage allows all team members 

to access the latest version of files, improving teamwork and reducing 

the chance of using outdated information. 

● Version Control: Organizing files in a structured way helps track design 

progress and manage different versions, making it easy to revert to 

previous designs if necessary. 

● Accessibility: Centralized storage ensures that authorized users can 

access files anytime and from any device, facilitating remote work and 

reducing delays in locating documents. 

 

 

1. Refer to the introduction you are requested to perform the following task : 

In this activity, suppose that you have a model and assemble of laptop docking station 

in SolidWorks with components such as a docking base, USB and HDMI ports, an circuit 

board, and a power adapter and you are asked to use that model and make an 

assemble  from the parts by mating the ports to the base, positioning the circuit board, 

and attaching the power adapter. Once verified, export the assembly in formats like 

STEP or STL for further use. 

2. Read the Key readings 3.3.2 in trainee manual 

3. Learn how to export an assembly in SolidWorks from the trainer. 

4. Follow along  the steps of exporting Assembly in SolidWorks. 

5. For more clarifications, ask question if any. 

  

 

Practical Activity 3.3.2: Exporting an Assembly in SolidWorks 

 

Task: 
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Key readings 3.3.2:Exporting an Assembly in SolidWorks 

● File location: When exporting an assembly, you need to specify the file location 

where you want to save the exported file. Choose a location on your computer 

or network where you can easily access the file later. 

●  File format: SolidWorks offers various file formats to export assemblies. An 

assembly is a collection of related parts saved in one SOLIDWORKS document file 

with “.sldasm” extension. By exporting the assembly in the desired file format, 

you can share, collaborate, or use the assembly in other applications as needed. 

✔ Steps to be followed to export a file: 
1. Open Assembly: 
2. Prepare the Assembly for Export 
3. Access the Export Function by click on File, click on Save as. 

 
4. Select Export File Format 
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5.Configure Export Options 
6.Choose the file location 

 
7.Export the Assembly 
8.Save and Close the Assembly 

✔ Note that: After saving, you can close the assembly or continue working as 
needed 
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✔ File Format Options: 

● STEP (.stp 

● IGES (.igs 

● Parasolid  

● STL (.stl) 

● PDF (.pdf). 

● It is necessary to choose File Location or file directory while exporting an assembly in 

SolidWorks. 

● You must know the Steps for Exporting Assembly 

 

HP provides various docking stations and monitors with standard dimensions to enhance user 

connectivity. As a technician, you will design a laptop and docking station in SolidWorks, using 

the specifications for the HP USB-C Dock G5 (300mm x 100mm x 10mm) and the HP Elite 

Docking Station (310 x 94 x 33 mm). Many HP monitors adhere to VESA mounting standards 

(100mm x 100mm or 75mm x 75mm) for compatibility. After completing the design, you must 

export the file, at least three different formats for review and further use. 

  

Points to Remember 

Application of learning 3.3 
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Learning outcome 3 end assessment 

 

 

Select the right answer: 

1. What feature allows you to create an assembly from an existing part in 
SolidWorks?  
a) Insert Components 
b) Make Assembly from Part 
c) Assembly Wizard 
d) Build Assembly 

2. How can you add an existing part or assembly into a current assembly? 
 a) Use "Open" and select the part 
b) Click "Component" then select "Existing Part/Assembly" 
c) Drag and drop from the toolbar 
d) Use "Sketch" and create the part from scratch 

3. Which tool is used to browse for components to insert into an assembly?  
a) Search Components 
b) Insert Components 
c) Component Library 
d) Browse Parts 

4. Where do you find the 'Insert Components' option in SolidWorks?  
a) File Menu 
b) Tools Menu 
c) Assembly Tab in the Command Manager 
d) View Tab 

5. What file format is used when importing a SolidWorks part?  
a) .STEP 
b) .SLDPRT 
c) .IGES 
d) .DXF 

6. To import a non-SolidWorks part like a STEP file, what must you do first? 
 a) Convert it in SolidWorks 
b) Use the 'Open' command and choose the correct file format 
c) Save it as a .SLDASM 
d) Use the 'Import Wizard' 

7. What is the purpose of applying mates in an assembly 
 a) To check interference 
b) To constrain components relative to each other 
c) To define material properties 
d) To export the assembly 

8. Which of the following is a standard mate type in SolidWorks?  
a) Symmetry 
b) Tangent 

Written assessment  
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c) Velocity 
d) Contact 

9. What does the "Coincident" mate do?  
a) Aligns two components parallel to each other 
b) Fixes components in one place 
c) Ensures two faces or edges touch each other 
d) Aligns components perpendicularly 

10. Which of the following is an advanced mate type?  
a) Distance 
b) Angle 
c) Width 
d) Parallel 

11. What is the function of a mechanical mate in SolidWorks 
 a) It constrains parts to rotate together 
b) It simulates specific mechanical movements like gears or cams 
c) It locks parts in place 
d) It connects parts with fixed distances 

12. Which mechanical mate would you use to simulate a gear mechanism? 
 a) Width Mate 
b) Screw Mate 
c) Gear Mate 
d) Symmetric Mate 

13. What is the function of the "Distance" mate in SolidWorks?  
a) It fixes two components at a specific distance from each other 
b) It aligns two components parallel to each other 
c) It aligns two components perpendicularly 
d) It sets two components to be coincident 

14. What type of analysis can you perform after applying mates?  
a) Force Analysis 
b) Structural Analysis 
c) Motion Analysis 
d) Color Analysis 

15. What is the purpose of performing mate analysis in SolidWorks?  
a) To check if the mates cause interference between components 
b) To verify mate positions in exploded views 
c) To add more mates to an assembly 
d) To remove redundant components 

16. When exporting an assembly, which command should you use to save the 
assembly?  
a) Export 
b) Save As 
c) Close and Save 
d) Transfer File  
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17. Which file format would you choose to export an assembly for use in another CAD 
software?  
a) .SLDASM 
b) .STEP 
c) .TXT 
d) .XLS 

18. Where do you specify the location to save an exported assembly file?  
a) In the Mates menu 
b) In the Save As dialog box 
c) In the Display tab 
d) In the Assembly Manager 

19. Which file format would you use to export a 2D drawing of your assembly? 
 a) .DXF 
b) .SLDPRT 
c) .IGES 
d) .PDF 

20. What should you do if you want to export the assembly including all associated 
components?  
a) Select 'Save As' and choose 'Include All Files' 
b) Use 'Pack and Go' feature 
c) Compress the files manually 
d) Use the 'Assembly Wizard' 

  

As a technician at a computer peripheral manufacturing company tasked with designing and 

assembling components for a new device, including a simple motherboard for an electronic 

device. Your responsibilities include creating a SolidWorks assembly of the motherboard, 

inserting and positioning components such as the processor, memory modules, heat sink, 

capacitors, fan, and resistors. You need to apply appropriate mates to ensure proper 

alignment and connectivity between the components. Additionally, you will insert external 

components to create non-editable geometry as part of the assembly.Once the assembly is 

complete, you will prepare it for a client review by exporting it in multiple formats. This 

includes generating a PDF for documentation, a DXF file for integration with the client's 

existing CAD system, and a high-resolution image for presentation. It is essential to ensure 

the accuracy and suitability of the exported files for review and further use. 

  

Practical assessment 
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Learning Outcome 4:Produce drawing 
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Indicative contents 

Indicative content 4.1: Setting drawing sheet layout 

Indicative content 4.2: Editing the title block 

Indicative content 4.3: Importing views 

Indicative content 4.4: Applying Visualization 

Indicative content 4.5: Exporting the drawing 

 

Key Competencies for Learning Outcome 4: Produce drawing 

Knowledge  Skills  Attitudes  

● Identification of drawing 

sheet layout standard 

size. 

● Identification the 

printer paper 

orientation 

● Setting drawing sheet 

layout 

● Editing the title block 

● Importing views 

● Applying Visualization 

● Exporting the drawing 

 

● Having Adaptability 

● Having Critical 

thinking capabilities 

● Having Creativity 

● Being Problem 

Solver  

● Being Decision 

Maker  

● Being a Team 

worker 
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Duration: 20 hrs  

Learning outcome 4 objectives:   

By the end of the learning outcome, the trainees will be able to:  

1. Select properly a drawing sheet layout used to produce SolidWorks drawings. 

2. Edit correctly the drawing sheet title block for producing SolidWorks drawings. 

3. Import correctly different components and their views in SolidWorks  

4. Apply proper visualization on drawing in SolidWorks software. 

5. Export properly the drawing in different file formats. 

 

Resources 

Equipment   Tools  Materials   

● Computer 

● Projector 

 

● SolidWorks software 

● Storage nedia 

devices (Flash disk, 

External hard disk) 

● Electricity 

● Didactic materials 
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Indicative content 4.1: Setting drawing sheet layout 

  

 

1: Read carefully and answer the following questions 

i. What are the standard sizes of drawing sheet? 

ii. Discuss on two main orientations of drawing sheets, and when would each be used? 

2: Write the findings on paper / flipchart.  

3:  Present the findings. 
4:  For more clarification, read key readings 4.1.1 in train manuaul 

5:  In addition, ask questions where necessary. 

 

Key readings 4.1.1: Setting drawing sheet layout   

 

When creating a drawing in SolidWorks, you need to set the drawing sheet layout, 

including the sheet size and orientation. This determines the dimensions and 

orientation of the drawing sheet on which you will create your technical drawings. 

Here are the options for setting the drawing sheet layout:  

✔ Standard Sheet Sizes in SolidWorks 

SolidWorks provides several standard sheet sizes to choose from when creating a 

drawing. These sizes follow international standards such as ISO (International 

Organization for Standardization) or ANSI (American National Standards Institute). 

✔ Standard ISO Sheet Sizes: 

● A0: 841 x 1189 mm 

● A1: 594 x 841 mm 

● A2: 420 x 594 mm 

● A3: 297 x 420 mm 

● A4: 210 x 297 mm 

✔ Standard ANSI Sheet Sizes: 

● A (Letter): 8.5 x 11 in 

● B: 11 x 17 in 

Duration: 3 hrs  

 

 

Theoretical Activity 4.1.1: Identification of drawing sheet layout setting 

Tasks: 
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● C: 17 x 22 in 

● D: 22 x 34 in 

● E: 34 x 44 in 

✔ Sheet orientation: The sheet orientation determines the alignment of the drawing 

sheet, whether it is in landscape (horizontal) or portrait (vertical)  

✔ Landscape orientation: The sheet is wider than it is tall. This orientation is suitable 

for drawings that have a wider aspect ratio or require more horizontal space to 

accommodate the drawing views or dimensions.  

✔ Portrait orientation: The sheet is taller than it is wide. This orientation is suitable 

for drawings that have a taller aspect ratio or require more vertical space to 

accommodate the drawing views or dimensions.  

The choice of sheet orientation depends on the nature of your drawing and the   

space required to present the information effectively.  

By setting the drawing sheet layout, including the sheet size and orientation, you 

can create a suitable canvas for your technical drawings in SolidWorks.  

✔ Custom Sheet Size: 

You can choose to create a custom sheet size if your project requires specific 

dimensions that are not available in the standard sizes. In this case, you can specify 

the width and height of the custom sheet size according to your needs.  

✔ To define Custom Size: 

To create a custom size, right-click on Sheet1 and choose Properties. 

Under Sheet Format, select Custom Size and enter the desired width and height. 

 

 

1. Refer to the introduction perform the activity of the following tasks: 

As a computer technician you are asked to choose and  modify the drawing sheet 

orientation from landscape to portrait in SolidWorks? 

2: Read   Key readings 4.1.2 in trainee manual 

3: Learn to modify a SolidWorks drawing sheet layout from the trainer. 

4: Modify drawing sheet orientation referring to the demonstrated steps of trainer 

5:Ask questions for any further clarifications  

 

Practical Activity 4.1.2: Setting Drawing Sheet Layout in SolidWorks 

Tasks:  
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Key readings 4.1.2 :Setting Drawing Sheet Layout in SolidWorks 

● Start a New Drawing 

● Select Sheet Format and Size 

 
You can choose standard sheet size as shown on the figure above or customize 

the sheet size as shown on the figure below: 

 

  
● Set Up the Drawing Sheet Layout 

 

✔ Sheet Orientation: 

● Landscape: Wider than tall; suitable for wider aspect ratio drawings. 
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● Portrait:  Taller than wide; suitable for taller aspect ratio drawings. 

 

 
✔ Steps to Set Drawing Sheet Orientation: 

● Open or Create a Drawing: 

Open an existing drawing or create a new one by navigating to File > New > Drawing. 

● Access Sheet Properties: 

In the Feature Manager Design Tree, right-click on Sheet1 (or the relevant sheet name). 

Select Properties from the context menu. 

● Set Sheet Size (Optional): 

Under Sheet Format, choose the desired sheet size from the standard options (ISO, 

ANSI) or define a Custom Size by entering width and height values. 
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● Standard Sheet Sizes: 

✔ ISO Sizes: 

✔ ANSI Sizes: 

● Trainees should know to customize Sheet Size 

● Sheet orientation: 

● Choosing between standard and custom sizes: 

 

 

A 3D designing company needs a professional technician to provide and set a very well-

organized drawing sheet layout for a 3D part designed in SolidWorks. As a technician who is 

familiar with SolidWorks design software you are hired to set the drawing sheet layout for 

presenting parts designed in SolidWork?   

 

  

Points to Remember 

Application of learning 4.1 
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Indicative content 4.2: Editing the title block 

  

 
1: Read the following questions and provide the answers 

i. What do you understand by the term title block?  

ii. What essential information should be included in a title block, and how does it aid 

in identifying the drawing? 

iii. Which of the following items is not typically included in a standard title block? 

a) Author’s name 

b) Part number 

c) Material specifications 

d) Drawing scale 

2:  Provide the answer and write them on papers/ flip chart  

3:  Present the findings/answers   

4:  Pay attention to the expert view from trainer 

5:  In addition, ask questions where necessary For more clarification and read the key 

readings 4.2.1. in the trainee manual 

  

Duration: 4 hrs  

 

 

Theoretical Activity 4.2.1:  Description of Title block 

Tasks:  
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Key readings 4.2.1.: Description of Title block 

In SolidWorks, the title block is an important component of a drawing that contains 

essential information about the drawing, such as the title, author, date, part 

number, and revision history. Here are the options for editing the title block:  

✔ Title block table:  

● The title block in SolidWorks is typically presented as a table format, allowing 

you to input and display information in a structured manner.  

● A title block is a sheet template that includes a border and details about the 

design firm, project, client, and sheet, such as names, logos, addresses, issue dates, 

and revisions. 

✔ Title block information / elements of title block: The title block in SolidWorks 

typically includes several elements of information that are commonly found in 

engineering drawings. These elements may vary depending on the specific 

requirements of your organization or project. Some common elements found in a 

title block include:  

● Drawing title: The name or description of the drawing. Part number: The unique 

identifier for the part or assembly represented in the drawing.  

● Revision history: The record of revisions made to the drawing, including revision 

letters, dates, and descriptions.  

● Author: The name or initials of the person who created the drawing.  

● Date: The date when the drawing was created or last modified.  

● Scale: The scale at which the drawing is presented.  

● Company logo: The logo or emblem of the company or organization associated 

with the drawing.  
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These elements can be customized and arranged within the title block table to 

meet your specific requirements.  

By editing the title block in SolidWorks, you can ensure that the necessary 

information is accurately represented on your technical drawings and convey 

important details about the drawing to others.  

 

1: Refer to the introduction read and answer the following questions: 

As a technician who have skills in SolidWorks,you are asked to set and edit the Title 

Block information in SolidWorks template and insert  elements of title block  

Read the Key readings 4.2.2 in trainee manual 

3: Pay attention on demonstrates on how to edit title block in SolidWorks. 

4: follow along  the steps of editing title block in SolidWorks. 

5: For more clarifications, ask question if any. 

  

 

Practical Activity 4.2.2: Editing title block 

 

Task: 
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Key readings 4.2.2.Editing the title block 

To edit the title block table, you can perform the following actions:  

Add rows or columns: You can add additional rows or columns to the title block 

table if you need to include more information or customize the layout.  

Merge cells: You can merge adjacent cells to create combined cells for specific 

information, such as merging cells to create a single cell for the drawing title or 

part number.  

Split cells: You can split cells into multiple smaller cells if you want to divide 

information into separate sections within the title block.  

Format cells: You can apply formatting options to the cells, such as changing the 

font, font size, alignment, and borders, to enhance the visual appearance of the 

title block.  

Steps for editing  title block in SolidWorks 

Open SolidWorks and select drawing template 

To enter Edit Sheet Format Mode do Right-Click anywhere in the blank area of the 

drawing sheet then edit sheet format 

 

Select a Text Field and Click directly on any of the text fields within the title block 

(such as the company name, drawing number, or date). 
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Click on the title block where you want to insert the new text field, and a cursor 

will appear for you to type the new information (e.g., revision number, designer’s 

name). 

 

Insert a New Text Field or If you want to add new text fields to the title block: 

Right click  

Go to the Annotation tab in the Command Manager  

Click on Note. 
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Add Notes/texts that you want 

 

Insert Custom Logos or Images (Optional) click on Insert > Picture> Browse and 

Select Image>Position and Resize the Image. 

 Go to File > Save to save the changes made to the drawing and Exit. 
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● The title block in SolidWorks is a table format that organizes essential drawing 

information. You can customize it by adding, merging, splitting, and formatting cells. 

✔ Common elements in a title block include: 

● Drawing title 

● Part number 

● Revision history 

● Author 

● Date 

● Scale 

● Company logo 

● You must to edit Sheet Format Mode 

● You must know the steps are used for editing existing text fields in title block 

● Inserting new text fields to insert new text fields for additional information  

Points to Remember 
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You are working as a products designer in a company that manufactures Electronics 

components. Your company has secured a new project to design an electronic circuit 

enclosure for a major electronics client. As part of the project, you need to create detailed 

technical drawings in SolidWorks for the manufacturing team. 

Before sharing the drawings with the client and the manufacturing team, you need to 

customize the Title Block on the drawing sheets to include specific information about the 

project, the client, and your company. The drawing must also adhere to the company's 

standards, include the client’s logo, and ensure proper documentation. 

   

Application of learning .4.2 
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Indicative content 4.3: Importing views 

  

 

 
1: Read carefully and provide answers to the following questions 

i.  Discuss on updating view palette in SolidWorks? 

ii.  What are the different types of views that can be imported into a drawing in SolidWorks? 

2: Provide the answer for the asked questions and write them on papers.  

3:  Present your findings findings/answers. 

4:  For more clarification, read the key readings 4.3.1. in trainee manual 

5:  In addition, ask questions where necessary. 

 

Key readings 4.3.1.: Description on Importing Views in SolidWorks 

✔ Importing views  

In SolidWorks, importing views into a drawing allows you to display different 

perspectives and representations of your model. Here are the options for 

importing views:  

✔ Updating view palette: The view palette in SolidWorks provides a visual 

representation of the available views that can be imported into your drawing. To 

update the view palette, you can perform the following actions:  

✔ Refresh views: If you have made changes to your model or added new views, you 

can refresh the view palette to update the list of available views.  

✔ Customize view palette: You can customize the view palette by adding or 

removing views from the list, rearranging the order of views, or grouping views 

based on specific criteria.      

Duration: 6 hrs  

 

 

Theoretical Activity 4.3.1:  Description on Importing Views in SolidWorks 

Tasks:  
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✔ Filter views: You can apply filters to the view palette to narrow down the list of 

available views based on specific criteria, such as view type, orientation, or custom 

properties.  

✔ Model view: A model view is a specific representation of your model that you can 

import into your drawing. Here are some options for creating and importing model 

views:  

✔ Standard 3D views: SolidWorks provides standard 3D views, such as isometric, 

front, top, right, and so on, which can be easily imported into your drawing.  

  

✔ View Orientation  

● Shortcut Keys:  

o Ctrl + 1 = Front view   

o Ctrl + 2 = Back view  

o Ctrl + 3 = Left view  

o Ctrl + 4 = Right view  

o Ctrl + 5 = Top view 

o Ctrl + 6 = Bottom view  

o Ctrl + 7 = Isometric view  
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o Ctrl + 8 = Normal To selection 

✔ Custom 3D views: You can create custom 3D views in SolidWorks by 

rotating, panning, or zooming in/out on your model to capture a specific 

perspective. These custom views can then be imported into your drawing.  

✔ Section views: Section views allow you to cut away a portion of your 

model to show internal features or hidden details. You can create section views 

and import them into your drawing.  

 
 

✔ Detail views: Detail views are used to magnify a specific area or feature of your 

model. You can create detail views and import them into your drawing.  

 

✔ Auxiliary views: Auxiliary views are used to show the model from a 

different angle or orientation to provide additional information. You can create 

auxiliary views and import them into your drawing.  

 

✔ Notethat:By importing views into your drawing, you can present different 

perspectives, details, and sections of your model to communicate the necessary 

information effectively. 
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1: Refer to the introduction read and complete the following activity: 

  Suppose that you have a 3 D object designed in SolidWorks, you are asked to import a 

model views, align/position them into a new SolidWorks drawing. 

2: Read   Key readings 4.3.2 in Trainee Manual 

3: Pay attention to the trainer Demonstration on hwo to import view. 

4: Follow along the steps are demonstrated by trainer then import view. 

5: Ask for Clarification if any 

 

Key readings 4.3.2.: Importing Views in SolidWorks 
In SolidWorks, importing views into a drawing allows you to display various 
perspectives of your model to effectively communicate information. 

• Updating View Palette:  

o Open SolidWorks and choose Drawing template 

o Click on View Palette  

 

 

Practical Activity 4.3.2. Importing views 

 

Task: 
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o Choose a part, component or assembly from the file location after clicking on the 

option shown in the figure below in red circle 

 

o Position your part, component or assembly views and click Esc key on your 

keyboard 

 

• Refresh Views: Update the view palette when changes are made to the model or 

new views are added. 
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• Customize Palette: Add, remove, or rearrange views, and apply filters to narrow 

down views by type or orientation. 

• Filter views: You can apply filters to the view palette to narrow down the list of 

available views based on specific criteria, such as view type, orientation, or custom 

properties. 

 

• Model Views: 

o Open SolidWorks and choose Drawing template 
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o Click on Browse 

 

 

⮚ Choose a part, component or assembly from the file location 

 

o Insert the views of your part, component or assembly and position them then press 

Esc key on your keyboard 
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✔ Standard 3D Views: Import common views like isometric, front, top, right, and 

others using shortcut keys (e.g., Ctrl + 1 for Front View). 

✔ Custom 3D Views: Create and import custom views by rotating or zooming in on the 

model for specific perspectives. 

✔ Section Views: Import views that cut through the model to show internal details. 

 

✔ Detail Views: Magnify a specific area of the model to highlight features. 
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✔ Auxiliary Views: Show the model from alternative angles for additional information. 
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● Importing views in SolidWorks allows you to display different perspectives of your 

model in a drawing. 
 

 

QX company needs to create a drawing of a 3D part of a computer case in SolidWorks for 
manufacturing purposes and you are hired to import multiple views of the 3D part into the 
drawing sheet. Make sure that you position the views appropriately on the drawing sheet and 
ensure that the views are correctly aligned, with proper scaling and dimensions. 

  

Points to Remember 

Application of learning .4.3 
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Indicative content 4.4: Applying Visualization 

  

 

 
1: Refer to the introduction read and answer the following questions: 

i.  What are the types of drawing views? 

ii.  What do you understand by the term “Annotation” in SolidWorks? 

iii.  What are the benefits of using section views and isometric views in SolidWorks when 
visualizing complex assemblies? 

2: Provide the answers for the asked questions 

3: Present your findings on the paper/flipchart. 

4:  Read key reading 4.4.1 for further understanding and ask clarification where necessary 

 

Key readings 4.4.1.: Description of visualization in SolidWorks 

In SolidWorks, applying visualization is an essential part of creating detailed and 

informative drawings.   

● Types of drawing views: SolidWorks offers various types of drawing views that 

allow you to represent your model from different perspectives. Some common 

types of drawing views include:  

✔ Orthographic views: These views show the model from different 

directions, such as front, top, right, left, bottom, and back, providing a 

comprehensive representation of the model.  

✔ Isometric views: Isometric views display the model in a three-

dimensional perspective, showing all three axes equally foreshortened.  

✔ Section views: Section views are used to reveal internal details of the 

model by cutting away a portion of the model along a specified cutting plane.  

Duration: 4 hrs 

 

 

Theoretical Activity 4.4.1:  Description of visualization in SolidWorks 

 

Tasks: 
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✔ Detail views: Detail views are used to magnify a specific area or feature of the 

model to show intricate details.  

✔ Auxiliary views: Auxiliary views are created to provide additional 

information about the model by showing it from a different angle or orientation.  

● Annotation: Annotation in SolidWorks refers to adding dimensions, notes, 

symbols, and other graphical elements to the drawing to convey important 

information. Some common annotation tools and features in SolidWorks include:  

✔ Dimensions: Dimensions are used to specify the size and location of 

features on the drawing. You can add linear dimensions, angular dimensions, radial 

dimensions, and more.  

✔ Notes: Notes are textual annotations that provide additional information 

or instructions related to the drawing. You can add notes using text boxes or 

callouts.  

✔ Symbols: Symbols are graphical representations used to convey specific 

meanings or instructions. SolidWorks provides a library of standard symbols that 

can be easily added to the drawing.  

✔ Balloons: Balloons are used to identify and label specific components or 

parts in an assembly.  

They are commonly used in assembly drawings to create parts lists or BOMs (Bill 
of Materials).  

 

● Display: The display options in SolidWorks allow you to control the visibility and 

appearance of components, features, and annotations in the drawing. Some 

display options include:  

✔ Hide/show components: You can selectively hide or show individual 

components in the drawing to focus on specific areas or details.  

✔ Display states: Display states allow you to save and switch between 

different configurations of component visibility, appearance, and display settings.  
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✔ Layer control: Layers can be used to organize and control the visibility of 

different elements in the drawing, such as dimensions, text, and symbols. 

 

 

1: Refer to the introduction read and answer the following questions: 

By using a component/part of your choice, after importing views in drawing template you 
are asked to apply different annotation tools and features that can be used during 
visualizing your drawing in SolidWorks and also apply different display styles used in 
SolidWorks when visualizing a drawing? 

2: :Read key reading 4.4.2 in trainee manual 

3: Pay close attention on trainers demonstration of how to apply visualization. 

4: Simulate  the steps observed from trainer and apply visualization. 

5:Ask for clarification if any 

 

Key readings 4.4.2. Applying visualization in SolidWorks 

● Types of drawing views: SolidWorks offers various types of drawing views that 

allow you to represent your model from different perspectives. Some common 

types of drawing views include:  

✔ Orthographic views: These views show the model from different 

directions, such as front, top, right, left, bottom, and back, providing a 

comprehensive representation of the model.  

✔ Isometric views: Isometric views display the model in a three-

 

Practical Activity 4.4.2: Applying visualization in SolidWorks 

 

Task:  
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dimensional perspective, showing all three axes equally foreshortened.  

✔ Section views: Section views are used to reveal internal details of the 

model by cutting away a portion of the model along a specified cutting plane.  

 

✔ Detail views: Detail views are used to magnify a specific area or feature of the 

model to show intricate details.  

 

✔ Auxiliary views: Auxiliary views are created to provide additional 

information about the model by showing it from a different angle or orientation.  
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● Annotation: Annotation in SolidWorks refers to adding dimensions, notes, 

symbols, and other graphical elements to the drawing to convey important 

information. Some common annotation tools and features in SolidWorks include:  

● Dimensions 

Steps for applying dimensions:  

o Click Annotations → Smart Dimension. 

o Select the edges, faces, or features you want to dimension. 

o Place the dimension by clicking on the drawing sheet. 

You can adjust the dimension properties, like tolerance, precision, or units, by 

double-clicking the dimension and editing the properties in the 

PropertyManager. 

● Notes 

  Steps for applying Notes: 

o Click Annotations → Note. 

o Click on the drawing sheet to place the note. 

o Type your text in the pop-up box. You can format the text, change the font, or 

apply borders from the options in the PropertyManager. 

●  Symbols 

Surface finish symbols specify the quality of the surface finish on a part. 
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o Go to Annotations → Surface Finish or Welding symbols . 

o In the Property Manager set parameters like size and length details. 

o Place the symbol on the relevant part of the drawing 

● Balloons  

o Click Annotations → Balloon. 

o Select the part or component in the drawing view. 

o The balloon will display the item number, which corresponds to the BOM. 

 

✔ Display: The display options in SolidWorks allow you to control the 

visibility and appearance of components, features, and annotations in the drawing. 

Some display options include:  

● Hide/show components: You can selectively hide or show individual components 

in the drawing to focus on specific areas or details.  

● Display states: Display states allow you to save and switch between different 

configurations of component visibility, appearance, and display settings. 
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• Dimension is most important elements in CAD drawings you must know the elements 

of diamensions.  

 

A designer is preparing a model presentation for a client and needs to enhance the model's 

appearance using various visualization tools in SolidWorks. Your job is to apply visualization 

techniques to improve the model’s appearance(color, texture, and material properties),add 

Section View for a clearer view of internal components. and aesthetics. In addition you have 

to provide screenshots of the model with the different visualization techniques applied. 

   

Points to Remember 

Application of learning .4.4 
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Indicative content 4.5: Exporting the drawing 

  

 

 
1: Refer to the introduction read the following questions and provide answers: 

i. What is the purpose exporting drawing to file formats like PDF, DWG, DXF, and JPEG in 

SolidWorks? 

ii. When should you use a PDF file format when exporting a SolidWorks drawing? 

iii. Discuss on why it is important to choose the correct export format when sharing drawings 

with manufacturers or clients?  

 2: Provide the answer for the asked questions and write them on papers.  

3:  Present the findings/answers to the whole class. 

4:  Pay attention to the expert view of trainer. 

5: For more clarification, read the key readings 4.5.1 in trainee manual. 

 

Key readings 4.5.1.: Description of Exporting drawing in SolidWorks 

Once you have completed your drawing in SolidWorks, you may need to export it 

for various purposes, such as sharing it with others or printing it. Here are the 

options for exporting the drawing:  

● File location: When exporting the drawing, you can choose the desired file 

location where you want to save the exported file. This can be a local folder on 

your computer, a network drive, or any other location accessible to you.  

● File format: SolidWorks offers several file formats to export your drawing, 

depending on your specific requirements. Some common file formats for exporting 

drawings include:  

✔ SolidWorks Drawing (*.slddrw, *.drw): This is the native file format for 

SolidWorks drawings. Exporting your drawing as a SolidWorks Drawing file allows 

others to open and edit it in SolidWorks.  

Duration: 3 hrs   

 

 
Theoretical Activity 4.5.1:  Description of Exporting drawing in SolidWorks 

Tasks: 
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✔ AutoCAD Drawing (*.dwg): This is a widely used file format for 2D 

drawings, compatible with AutoCAD and other CAD software. Exporting your 

drawing as a DWG file allows others to open and work with it in AutoCAD.  

✔ Drawing Exchange Format (*.dxf): DXF is another commonly used file 

format for 2D drawings, compatible with various CAD software. It allows for the 

exchange of drawing data between different programs.  

✔ Portable Document Format (*.pdf): Exporting your drawing as a PDF file 

ensures that it can be easily viewed and printed on any platform or device without 

the need for specialized software. PDF files also preserve the formatting and layout 

of the drawing.  

✔ Tagged Image File Format (*.tif): TIFF files are raster image files that can 

be exported from SolidWorks. This format is useful when you need a high-quality 

image of your drawing for documentation or presentation purposes.  

✔ Joint Photographic Experts Group (*.jpeg): JPEG is a commonly used 

image format that allows for compressed files with good image quality. Exporting 

your drawing as a JPEG file is suitable when you need to share the drawing as an 

image.  

✔ Portable Network Graphics (*.png): PNG is another image format that 

supports lossless compression. It is suitable for exporting drawings with 

transparency or when you need a high-quality image with a smaller file size 

compared to TIFF or JPEG.  

 

 

1: Read carefully and answer the following questions 

i. How can you export a SolidWorks drawing to DWG or DXF format? What 

considerations must you keep in mind during this process? 

ii. How would you export a SolidWorks drawing to a 3D PDF, and what features does 

a 3D PDF provide compared to a standard 2D PDF? 

 

2: Provide the answers to the above questions 

3: Read Key readings 4.5.2 

 

Practical Activity 4.5.1 Exporting drawings in SolidWorks 

 

Task:  
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4: Insert any component into SolidWorks drawing template and export it into any format that 

you want  

5: In addition, ask questions where necessary. 

 

Key readings 4.5.2 Exporting a Drawing in SolidWorks 

● Method1 
o Open the Drawing in SolidWorks: 
o Launch SolidWorks: Open SolidWorks from your desktop or program menu. 
o Open an Existing Drawing: To export a drawing, you must first have it open. Click 

File > Open and browse to the desired drawing file (.SLDDRW) you want to export. 
o Prepare the Drawing for Export and Adjust the Sheet Size and Scale (Optional) 
o Save the Drawing with a format of your choice in the Save As dialog box, under 

Save as type, select a format from the dropdown list. 

 

● Method 2 :Export the Drawing as a DXF or DWG (For CAD Software): 
o Go to File > Save As: Click File and then select Save As. 
o Choose DXF/DWG as File Type: In the Save As dialog box, select either DXF or 

DWG as the file type from the dropdown menu. 
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o Set DXF/DWG Export Options: Click the Options button to configure the export 
settings: 
Version: Choose the version of AutoCAD for compatibility (e.g., AutoCAD 2013, 

AutoCAD R12). 

Scale output 1:1: This ensures that the dimensions are exported accurately. 
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Preview and Confirm the Output: SolidWorks will show a preview window to check 

the layout of the DXF/DWG file. Ensure everything looks correct before 

proceeding. 

o Save the DXF/DWG: Select the file location, give the file a name, and click Save. 
o Export as an Image File (JPEG, PNG, TIFF, etc.): 

Go to File > Save As 

Choose the Image Format(From the Save as type dropdown, select the desired 

image format, such as JPEG, PNG, TIFF, or BMP. 

Set Image Quality Options: Click Options to adjust image settings such as resolution 

(DPI), size, and color depth. 

Save the Image File: Select the file location, give it a name, and click Save.. 

  

 
● You must know how to choose where to save the exported file, such as a local folder 

or network drive. 
  File Format Options: 

✔ SolidWorks Drawing (.slddrw, .drw) 
✔ AutoCAD Drawing (*.dwg) 
✔ Drawing Exchange Format (*.dxf) 
✔ Portable Document Format (*.pdf) 
✔ Tagged Image File Format (*.tif 
✔ Joint Photographic Experts Group (*.jpeg) 
✔ Portable Network Graphics (*.png) 

Points to Remember 
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You are a technician at a company that designs electronic components. Your team has 

recently completed detailed technical drawings for a new component, and you are tasked 

with preparing these drawings for a product design review with both internal team members 

and external clients. 

You need to export the SolidWorks drawings in different formats to meet various 

requirements for the review process. You will create a PDF for internal review, DXF/DWG files 

for integration with other CAD systems, and image files for visual presentations.  

Application of learning 4.4 
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Learning outcome 4 end assessment 

 

 

Choose the correct Answer:     

1. What do you understand by the term Title Block? 

a) A decorative border around the drawing 

b) A block containing the main views of the part 

c) A section of the drawing that provides essential information about the drawing 

d) A tool used to measure dimensions 

2. What essential information should be included in a Title Block, and how does it aid in 

identifying the drawing?  

a) Part name, author, date, and drawing number, and it helps identify the drawing by 

providing clear and concise information 

b) Only the part name and date, and it helps to simplify the drawing 

c) Scale and color of the part, and it helps control the size of the drawing 

d) File location and project notes, helping track revisions 

3. How does the customization of the Title Block layout improve communication between 

the designer and the manufacturer or client? 

 a) By making the drawing look more professional 

b) By adding more details than necessary 

c) By allowing specific information relevant to the project to be easily seen and understood 

d) By adjusting the size of the drawing sheet 

4. Select the correct answer: What is the primary purpose of a Title Block in a SolidWorks 

drawing?  

a) To display 3D views of the part 

b) To provide detailed technical specifications 

c) To summarize key information about the drawing, such as the part name, author, and 

scale 

d) To control the visibility of different drawing layers 

5. Which of the following items is NOT typically included in a standard Title Block? 

Written assessment   
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 a) Author’s name 

b) Part number 

c) Material specifications 

d) Drawing scale 

6. In SolidWorks, which process can you use to edit the Title Block information in an existing 

drawing?  

a) Right-click on the drawing sheet and select "Edit Sheet" 

b) Double-click the Title Block 

c) Right-click on the drawing sheet and select "Edit Sheet Format" 

d) Select "Insert" from the menu and choose "Title Block" 

7. What feature can be used to automatically fill out Title Block fields based on the 

properties of the part or assembly in SolidWorks? 

 a) Smart Dimension 

b) Custom Properties 

c) Bill of Materials (BOM) 

d) Annotations 

8. What is the purpose of visualization tools in SolidWorks, and how do they contribute to 

the design process?  

a) They add colors to the drawing 

b) They help create complex geometries 

c) They allow users to preview the design, improving decision-making and presentation 

d) They calculate the mass of the parts 

9. Explain the difference between Detail view and Auxiliary view in SolidWorks. When 

would you use each tool?  

a) Detail view shows zoomed-in sections of the model, while Auxiliary view provides 

projections from a slanted plane. 

b) Both are used to measure distances in the model. 

c) Auxiliary view is only used for circular parts. 

d) Detail view and Auxiliary view are not related to the drawing process. 

10. How does applying materials and textures to a 3D model in SolidWorks help in 

visualizing the final product?  

a) It creates a photorealistic view of the final product, aiding in communication with clients 

and testing material properties. 



133 | SolidWorks Designs–Trainee Manual 

b) It makes the part heavier. 

c) It helps avoid making mistakes during assembly. 

d) It doesn't impact the design process. 

11. What are the benefits of using section views and isometric views in SolidWorks when 

visualizing complex assemblies?  

a) Section views show internal features, while isometric views provide a 3D perspective for 

better overall visualization. 

b) Section views are used for coloring, and isometric views are for cutting. 

c) They help add text annotations. 

d) They adjust the scaling of the model automatically. 

12. A3 paper size is larger than A2 paper size. 

 a) True 

b) False 

13. What is the default sheet orientation for most drawings? 

 a) Landscape 

b) Portrait 

c) Horizontal 

d) Vertical 

14. What are the two main orientations of drawing sheets, and when would each be used? 

 a) Landscape and Portrait; Landscape is used for wide designs, while Portrait is used for 

taller designs 

b) Vertical and Horizontal; Horizontal for large parts and vertical for smaller ones 

c) North and South orientations for parts 

d) Left and Right orientations for better visibility 

15. Explain why different drawing sheet sizes (A0, A1, A3, etc.) are used in drawings?  

a) To accommodate different scales and levels of detail required in the project 

b) To organize the parts into different sections 

c) To avoid confusion when printing 

d) To reduce the number of dimensions on a drawing 
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As a technician you are tasked with assisting a company in designing a PCB enclosure for a key 

client using SolidWorks. Your responsibilities include setting up an organized drawing sheet 

layout, customizing the Title Block with project and client details, and adhering to company 

standards. You will import multiple views of the 3D part into the drawing sheet, ensuring 

proper alignment, scaling, and dimensions for manufacturing. Additionally, you will enhance 

the model’s appearance using visualization techniques, including colors, textures, and section 

views. Finally, you will export the drawings in various formats, such as PDF, DXF/DWG, and 

image files, for internal and external reviews.  

Practical assessment 
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